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1 INTRODUCTION

CellaVision® DC-1 is an automatic cell-locating device that is used to analyze blood cell morphology
in peripheral blood samples.

These Instructions for Use describe how to process peripheral blood samples on the analyzer. For
information on how to review processed orders, see the CellaVision Review Software Instructions for
Use.

For all available instructions and settings, see the built-in help. To access the built-in help, on the
Help menu, click Help.

Note: The applicability of some sections in this document depends on which applications are
installed on the analyzer. Contact your local vendor for more information.

1.1 Intended use of the CellaVision® DC-1

The CellaVision® DC-1 is an automated cell-locating device intended for in-vitro diagnostic use in
clinical laboratories. The CellaVision® DC-1 is intended to be used by operators, trained in the use of
the device.

1.1.1 Intended use of the CellaVision Peripheral Blood
Application

The CellaVision Peripheral Blood Application is intended for differential count of white blood cells
(WBC), characterization of red blood cell (RBC) morphology and platelet estimation.

The CellaVision® DC-1 with the CellaVision Peripheral Blood Application automatically locates blood
cells on peripheral blood smears. The application presents images of the blood cells for review. A
skilled operator trained in recognition of blood cells, identifies and verifies the suggested
classification of each cell according to type.

1.2 Warnings and precautions

Carefully study the meaning of safety alerts and symbols. Read all the safety information and
instructions in this manual before you use the system.

Warning!
If you are not suitably trained or fail to follow the instructions provided in this manual, it
can damage or deteriorate the system and cause misleading results or even injury.

1.2.1 Safety alerts

Make sure that you always read, understand, and follow all safety alerts that may appear in this
manual.

PM-10895-01 9
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I 1 Introduction

Alerts

Explanation

c Warning! Can cause personal injury.

Warning!

Risk of infection.

j Caution! Can cause damage to the system.

0 Important! Can cause misleading results.

1.2.2 Symbols

Depending on the product, you may find the following symbols on the analyzer or the packaging
material.

Symbol

31°C
18°C
80
'
20

LOT

Meaning

Caution.

Indicates the need to consult the Instructions for Use for important cautionary
information, such as warnings and precautions, that cannot be presented on the
medical device itself.

Risk of infection.

Indicates that there are potential biological risks associated with the medical device.

In vitro diagnostic medical device.

Indicates a medical device that is intended to be used as an in vitro diagnostic medical
device.

Temperature limitation.
Indicates the temperature limits to which the medical device can be safely exposed.
Humidity limitation.

Indicates the range of the humidity to which the medial device can be safely exposed.

Batch code.

Indicates the manufacturer's batch code so that the batch or lot can be identified.

10
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1 Introduction I

Symbol

REF

»
4

LR EIKALLE

Meaning

Catalog number.

Indicates the manufacturer's catalog number so that the medical device can be
identified.

Serial number.

Indicates the manufacturer's serial number so that the medical device can be
identified.

Manufacturer.

Indicates the medical device manufacturer.

Date of manufacture.
Indicates the date when the medical device was manufactured.

The in vitro diagnostic system described in this manual is marked with a CE-mark
which shows conformity to the applicable European directives and regulations.

This symbol is only valid in the European Community and indicates separate disposal
of waste of electrical and electronic equipment.

The EAC mark shows that the product conforms to all technical regulations of the
Eurasian Customs Union assessment procedures.

Consult Instructions for Use or consult electronic Instructions for Use.

Indicates the need for the user to consult the Instructions for Use.

Standby button.

Slide positioning in the loading tray.

Make sure that the labeled or frosted end of the slide is facing right. If the slide is
placed any other way, the analyzer might use a bad part of the smear. This can cause
unreliable results.

Direct current.

Indicates that the analyzer is suitable for direct current only.

PM-10895-01
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1.2.3 General safety

Warning!

Only trained personnel may perform service and maintenance on this analyzer.

Warning!

Only trained service personnel may install this analyzer.

c Warning!
To avoid injury from electrical shock, take the following precautions before and during
maintenance work:

» Avoid standing on damp floors.

» Disconnect the power plug from the mains supply electrical outlet before working on
any high-voltage circuitry.

» Read and follow all warning and caution labels.

» Make sure that your test equipment is in good working condition.

Warning!

If the analyzer is not used in a manner specified by the manufacturer, the protection
provided by it may be impaired.

Warning!

Do not tamper with any sensors or safety devices. They help to prevent personal injury
and damage to the system.

Warning!
Risk of infection. When you perform any work on the analyzer, such as preparation,
testing, postprocessing, and maintenance, always wear protective disposable gloves.

When finished, wash your hands thoroughly with soap and water and then apply a
disinfectant.

Warning!

B B PP

Risk of infection. Handle samples with caution. Use protective disposable gloves and
tweezers when removing broken slides from the analyzer. Glass shards from broken slides
can cause serious cuts and pose a danger of infection. If infectious material enters the
eyes or an open wound, wash with copious amounts of water and seek for immediate
medical advice.

12 PM-10895-01
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Warning!
Avoid getting immersion oil on your skin as it may cause skin sensitization. Wear
protective gloves before you handle the oil pack, slides, or other parts that can come into

contact with immersion oil. If you get immersion oil on your skin, clean it off with soap and
water.

Caution!

Place the analyzer in a location where it is not exposed to bumps or vibrations, excessive
temperature variations or direct sunlight.

Caution!
Leave at least 20 cm clearance around the analyzer to ensure adequate ventilation.

supply.

Caution!
Do not place magnets on any parts of the analyzer.

Caution!

Do not install or run any software that is not supplied with the analyzer. You may install an
anti-virus program but we recommend that you do not scan the database files.

Caution!

Fluids spilled on the surfaces of the analyzer may cause it to malfunction or deteriorate.
Immediately wipe off any spilled fluids using a soft tissue.

c Caution!
Place the analyzer so that it's easy to operate and disconnect from the mains power

0 Important!
Report any serious incident that occurs about the analyzer to the manufacturer and the
competent authority in the European Union (EU) Member State where the user is located.

PM-10895-01 13
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Important!

0 To have the analyzer comply with current medical device registrations, always use the
original CellaVision AB spare parts and their specified components. These spare parts are
safe to use, and comply with regulatory requirements and approvals.

If the analyzer contains components that are not original CellaVision AB spare parts,
CellaVision AB is not liable:

e Under any warranty (whether express or implied, by law or otherwise) of such analyzer.
e For any malfunction of such analyzer.

» For any lack of compliance with current registrations of such analyzer.

1.2.4 Electrical safety

Warning!
Connect the system only to a grounded electrical outlet. To maintain electromagnetic
compatibility, use only original CellaVision AB spare parts and their specified components.

Warning!

The mains power supply cord and plug used with the system must comply with any
national regulations.

Warning!

The power supply must have proper ventilation around it and be free of any covering
objects.

Warning!

To disconnect from mains supply, pull off the power plug from the mains supply electrical
outlet. Do not use the standby switch.

Warning!

This equipment has been designed and tested to CISPR 11 Class A. In a domestic
environment it may cause radio interference, in which case you may need to take
measures to mitigate the interference.

Warning!

Do not use this device in close proximity to sources of strong electromagnetic radiation, as
these may interfere with proper operation. Evaluate the electromagnetic environment
before you operate the device.

14 PM-10895-01
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Warning!
Use only the UL recognized battery CR2032 with maximum 10 mA abnormal charging
current.

The battery must be changed by trained service personnel. Using other than specified
battery or installing the battery incorrectly can cause fire or explosion.

c Caution!
Use only the power supply that came with the analyzer.

0 Important!

External computing devices connected to the LAN or the communication connector on the
analyzer must have Limited Power Source and SELV circuit according to the standards UL
60950 for US, CAN/CSA-C22.2 No. 60950 for Canada and IEC60950-1 for other countries.

1.2.5 Mechanical safety

Warning!
Keep clothing and fingers away from moving components.

1.3 Theory of operation

From a peripheral blood sample, typically flagged by a cell-counter indicating an abnormal
morphology, a thin blood film is wedged on a glass slide (a blood smear). The blood smear is then
stained with Romanowsky stain.

The operator places the slide in the loading tray of the analyzer.

The operator enters the order ID for the slide, either manually or using an optional barcode reader.
If a Laboratory Information System (LIS) is used, the analyzer automatically fetches order data for the
sample from the LIS. Otherwise, the operator enters this information manually.

The operator closes the input hatch and starts the processing. The analyzer automatically moves the
slide under the microscope.

The analyzer looks for a monolayer in the smear. Once a monolayer is found, the analyzer scans the
monolayer in a battlement pattern. While doing this, the analyzer locates WBCs and stores high
quality images of each located WBC. The analyzer also locates and stores an image of a part of the
RBC monolayer. When enough WBCs and the image of the RBC monolayer have been captured, the
analyzer moves the slide back to the loading tray.

The analyzer pre-classifies each located WBC. It also pre-characterizes the RBC morphology. These
preliminary results, that is, the pre-classifications, pre-characterization, and the images are stored in
a database.

A skilled operator, trained in the use of the software and in recognition of blood cells, then opens the
order to review and verify the preliminary results. The review can be done either at the analyzer or
using the CellaVision Remote Review Software.

PM-10895-01 15
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| 1incoguction ..
1.4 Applications

The analyzer supports the CellaVision Peripheral Blood Application.

1.4.1 CellaVision Peripheral Blood Application

The CellaVision Peripheral Blood Application is included in the CellaVision DM Software. You can use
it for WBC classification, RBC characterization, and platelet estimation.

The CellaVision Peripheral Blood Application:

» Presents an image of every located nucleated cell or object.

» Presents and suggests cell classification (pre-classification) for WBCs.

» Allows you to identify, confirm or modify (re-classify) the suggested classification of WBCs.
» Presents an overview image from the RBC monolayer.

» Presents and suggests RBC morphological characteristics (pre-characterization) in the form of
grades.

» Allows you to confirm or modify the pre-characterization of RBC morphology.

» Presents an overview image and facilitates platelet estimation.

WBC classification
The CellaVision Peripheral Blood Application automatically pre-classifies WBCs into these classes:
» Band neutrophils

» Segmented neutrophils

» Eosinophils

» Basophils

* Lymphocytes

¢ Monocytes

e Promyelocytes

* Myelocytes

» Metamyelocytes

» Blast cells

e Lymphocytes, variant forms
* Plasma cells

The CellaVision Peripheral Blood Application automatically pre-classifies non-WBCs into these
classes:

16 PM-10895-01
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e Nucleated RBC

¢ Giant thrombocytes

» Thrombocyte aggregations
e Smudge cells

e Artefacts

Cells and objects pre-classified with a low confidence level are pre-classified as Unidentified.

You can manually re-classify cells and other objects to any of the above classes and also to these
classes:

e Reactive lymphocytes

e Abnormal lymphocytes

¢ Immature eosinophils

* Immature basophils

¢ Promonocytes

e Prolymphocytes

e Large granular lymphocytes
e Hairy cells

e Sézary cells

* Megakaryocytes

e Upto 15 user-defined cell classes

o Other. You can use this class for cells that are identified as WBCs other than those listed above,
and that you want to include in the differential count.

» Not classed. You can use this class for cells and objects that you can't identify, and want to exclude
from the differential count.

Quantitative results for WBCs are the number of user classified cells in each cell class, and its
percentage of the total number of WBCs counted.

Quantitative results for non-WBCs are the number of user classified cells or objects per 100 WBCs.

RBC characterization

The CellaVision Peripheral Blood Application pre-characterizes the RBC morphology by shape, color
and size, and suggests preliminary grading for these morphological characteristics:

e Polychromatic cells
e Hypochromatic cells

¢ Anisocytosis

PM-10895-01 17
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I 1 Introduction

¢ Microcytes
¢ Macrocytes
» Poikilocytosis

You can change the suggested preliminary grading for the above morphological characteristics, and
manually specify grading for these morphological characteristics:

e Targetcells
 Schistocytes

* Helmet cells

* Sickle cells

» Spherocytes

« Elliptocytes

e Ovalocytes

» Teardrop cells

¢ Stomatocytes

e Acanthocytes

e Echinocytes

» Howell-Jolly bodies

» Pappenheimer bodies
» Basophilic stippling

¢ Parasites

» Up to 10 user-defined characteristics

Semi-quantitative results for RBC morphology depend on grading criteria entered by the laboratory.

Platelet estimation

For the platelet estimation, the analyzer captures an overview image of the RBC monolayer.

Depending on the software configuration, you can use one of these methods to calculate platelet
concentration:

» Count platelets in one part (grid square) of the overview image at a time and enter the number of
platelets for each grid square.

» Estimate an average number of platelets per grid square.

+ Manually estimate platelet concentration.

18 PM-10895-01
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1 Introduction I

Semi-quantitative estimates of PLT concentration depend on grading criteria entered by the
laboratory.

Quantitative estimates of PLT concentration are the average number of PLTs per HPF multiplied by
the PLT estimate factor x10e9/L.

1.5 Components and mechanical operation

Major parts of the analyzer

¢ System computer
An embedded PC that runs Windows® and the CellaVision DM Software.

» XY stage module
Moves the slide to and under the microscope.

» Microscope module
Consists of an objective, a relay lens, and a focus mechanism.

* Imaging module
Captures images and controls the motors.

* LED module
Provides light to the microscope.

1 Hood 7 System computer
2 Stand-by button 8 Imaging module

3 Status light 9 Microscope module
4 USB 10 Loading tray

5 Input hatch 11 XY stage module
6 Drip tray 12 LED module

1.6 References to scientific literature

Bain, B.J., Bates, |., Laffan, M. A., & Lewis, S. M. (2012). Dacie and Lewis Practical Haematology (11th
ed.). London: Churchill Livingstone.
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Pathologists.
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1.7 References to standards
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NCCLS. Method Comparison and Bias Estimation Using Patient Samples; Approved Guideline—Second
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1.8 Patents

CellaVision AB has the following hardware and software patents:

Patent no.
AU 2015259903
CN 200980153358.5, CN 201210433235.0, CN 201580024601.9

DE 60045076, DE 602004008471, DE 602007037624, DE 60231032, DE 602008017260,
DE 602009011617, DE 602010005069

EP 1377865

FR 1210634, FR 1377865, FR 1646964, FR 1986046, FR 2383600, FR 2204686, FR 2310892
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Patent no.

GB 1210634, GB 1377865, GB 1646964, GB 2383600, GB 1986046, GB 2204686, GB 2310892
JP 5198476, |P 5215474, JP 5461630, JP 5539489, JP 6235168

SE 0101319, SE 9902863, SE 1350568-0, SE 1550394-9

US 6268611, US 6341180, US 7034883, US 7327901, US 9672447, US 9676095, US 7450762,
US 8914255, US 9180593

Other patents pending.

PM-10895-01 21
Revised: 2021-10-31






2 Operating procedure I

2 OPERATING PROCEDURE

This section provides information on how to use the analyzer and the CellaVision DM Software to
process samples.

2.1 Turn on the analyzer

1. Make sure that the hood and the input hatch are closed.

2. Press the Stand-by button on the analyzer.

Gu

O

o

The status light is steady yellow during analyzer start.

3. Press CTRL+ALT+DEL and log on to Windows® using these credentials:
User name: cvuser
Password: pass

4. Wait for the analyzer to start and the status light to be steady green. Do not open the input hatch
during startup.

If the startup test fails due to a mechanical error, the status light flashes red.

Error messages may occur during startup. For more information, see 6.8 Startup error messages
on page 88.

5. Double-click the CellaVision DM Software icon on the desktop.

6. When the Log On dialog appears, enter your User name and Password.
If you want to log on using your Windows® user name, select Use Windows Authentication.
If you want to process samples without logging on, select Start without logging on. With this

option, you can process samples in the System Control View E No patient data is visible.

PM-10895-01 23
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I 2 Operating procedure

7. Inthe Database list, click the database you want to log on to, and then click OK.

Note: You must be connected to a database to review slides. If you don't see the database that
you want to connect to in the Database list, create the connection as instructed in 4.1.1 Manage
databases on page 48.

The analyzer performs self tests at software start up and during operation.

At software start up, the analyzer tests both the hardware and the software components for defects,
and for various requirements necessary to operate the analyzer. If LIS communication is enabled, it
also checks the connection to the LIS.

After each processed slide, the analyzer checks the motor positions. At certain points during
operation, the analyzer compares the database size to the rules set for archiving or automatically
deleting old entries. This is to make sure that the database is kept at a maintainable size.

During operation, the analyzer also tests communication with and response of the hardware. If an
error occurs during slide processing or other operation, an error message is displayed.

2.2 Prepare slides

i Warning!

Wear protective gloves when handling blood or any other samples of human origin, or
equipment contaminated with such samples. Discard the gloves, wash your hands
thoroughly with soap and water, and then apply a disinfectant. Any samples of human
origin can transmit infectious diseases.

If blood or any other samples of human origin enters the eyes or an open wound, wash
with copious amounts of water and seek immediate medical advice.

You need well-prepared slides to get valid results. When the analyzer processes the slide, it starts
scanning the slide 33 mm from its end.

The blood smear must:

* Be atleast 30 mm long.

230 mm _‘
33 mm e
5-15/mm

e Terminate 5to 15 mm from the end of the slide.

 Start near the labeled or frosted end of the slide with a gradual transition in thickness and without
any grainy streaks, troughs, ridges, holes, or bubbles.

If an issue occurs during slide processing, you receive a warning with information about the issue.

24 PM-10895-01
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2 Operating procedure I

2.2.1 Prepare peripheral blood smears

We recommend that you use an automatic slide maker-stainer, but you can also smear and stain
slides manually.

To prepare a peripheral blood slide

1. Collect blood from a vein or by skin puncture in an EDTA sample tube (K;EDTA or K3EDTA,
1.5+0.15 mg/mL in liquid or powder form).

2. Mix the sample carefully with the anticoagulant.
3. Store the tube at room temperature.

4. Prepare the blood smears according to your laboratory's procedure.
We recommend that you prepare the blood smears within 4 hours of blood collection.

Examples of acceptable blood smears

These slides meet the specifications and can be processed with the analyzer.

e
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I 2 Operating procedure

Examples of unacceptable blood smears

These slides don't meet the specifications and can't be processed with the analyzer.

Related topics
» For more information on what types of slides to use, see 7.3.1 Slides on page 104.

» For more information on recommended staining recipes, see 2.2.3 Staining below.

2.2.2 Label slides

You must label all slides that are processed on the analyzer with patient or order information stated
in your laboratory policy. If you use the optional handheld barcode reader, you can have a barcode
label on your slides. Print the label and place it correctly on the slide according to specifications in
7.3.2 Barcodes on page 105.

2.2.3 Staining

The analyzer is optimized to process slides stained with May Grinwald Giemsa (MGG) stain, Wright
stain, and Wright-Giemsa stain.

If you use a slide maker-stainer, use the staining recipes recommended by the manufacturer.
If you stain your slides manually, use the staining recipes recommended by the reagents provider.

Note: Differences in staining results can result, for example, from alterations in pH and reagents. To
achieve best results, you may need to do local adjustments. Pay attention to pH variations in water.

2.3 Process slides

You can use the analyzer to process slides with blood smears from peripheral blood. The processing
time depends on the type of analysis and the concentration of WBCs.

26 PM-10895-01
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To process a slide

1. Open the input hatch and place the slide, with the blood smear facing up, in the loading tray.

0 Important!

Make sure that the labeled or frosted end of the slide is on the right. If the slide is
placed any other way, the analyzer might scan a bad part of the smear. This can cause
unreliable results.

2. If adialogis open, close it.

3. Inthe System Control View E click in the Slide ID text box.

NEW ANALYSIS
Slide ID

Note: You can also use an optional barcode reader to read the barcode on the slide.

4. Inthe Enter Slide ID dialog, enter the Slide ID exactly as written on the slide.

Enter Slide 1D >

Slide 1D

ox

5. Click OK.
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I 2 Operating procedure

6. If the analyzer isn't connected to the LIS, or if the order is not available in the LIS, you can enter
additional patient information and choose what type of analysis to perform.

Patient D
First name
Last name
Birth date Yy MM || DD

Gender Male Female

Ethnic origin
Ward
Ordering physician

Patient comment

Tvpe of analysis WEC
REC
PLT

Mumber of WBCs to count
WEBC count [x1029/1)
REBC conc. [x10e12/L)

Sample date Y Ik DD

STAT slide

7. Hold the tip of the oil bottle close to the slide without touching it, aim for the red colored marker,
and place two drops of the immersion oil on the slide.

0 Important!
Use only CellaVision® immersion oil with the analyzer. Make sure that there are no air
bubbles present in the oil as they can interfere with slide processing.

Warning!
Avoid getting immersion oil on your skin. Wear protective gloves before you handle the

oil, slides, or other parts that can come into contact with the oil. Immersion oil can
cause skin sensitization. If you get oil on your skin, clean it off with soap and water.

8. Close the input hatch.
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2 Operating procedure I

9. To start processing the slide, in the System Control ViewE, click Start ™ .
The status light is steady yellow while the analyzer processes the slide.

- ©
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0.

10. Wait for the processing to finish. This takes a couple of minutes.
The status light flashes green when the processing is complete.
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Note: If an issue occurs during slide processing, you receive a warning with information about
the issue.

11. Open the input hatch and remove the slide. The status light is steady green indicating that the
analyzer is in idle mode.

12. If adialog is open, close it.

Note: Depending on the slide processing issue, images and preliminary results may still be available.
You need to assess if the smear quality is good enough to review the results.
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Related topics

» For more information on what types of slides to use, see 7.3.1 Slides on page 104.

» For more information on how to add order information manually to the database before
processing a slide, see 2.3.2 Add orders manually on the facing page.

» For more information on how to keep the database from growing too large, see 4.1.2 Manage
database size on page 50.

2.3.1 Mark emergency samples (STAT)

You can mark orders as STAT in the Database View on the Processed Orders tab. You can also
mark orders as STAT on the Pending Orders tab when you add orders manually or before you
process the manually added orders. You can send the STAT status via the LIS with the order
information.

To mark orders as STAT on the Processed Orders tab

1. In the Database View on the Processed Orders tab, select the order or orders you want to mark

as STAT.

» To select a consecutive group of orders, click the first order, hold down Shift, and then click the

last order.

e To select non-consecutive orders, hold down Ctrl, and then click each order that you want to
select.

2. If you selected only one order, do one of the following:

* Click Mark as STAT ™ .

» Right-click the selected order, and then select Mark/Unmark as STAT.

3. If you selected several orders, do one of the following:

* Click Mark as STAT * , then select Mark all selected orders and click OK.

 Right-click the selected orders, select Mark/Unmark as STAT, then select Mark all selected

orders and click OK.

To mark orders as STAT on the Pending Orders tab

Note: You can mark an order as STAT directly when you manually add it.
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1. In the Database View on or the Pending Orders tab, select the order or orders you want to
mark as STAT.

» To select a consecutive group of orders, click the first order, hold down Shift, and then click the
last order.

« To select non-consecutive orders, hold down Ctrl, and then click each order that you want to
select.

2. Right-click the selected order or orders.
3. Ifyou selected only one order, select Mark/Unmark as STAT.

4. Ifyou selected several orders, select Mark/Unmark as STAT, then select Mark all selected
orders and click OK.

2.3.2 Add orders manually

If you need to process a slide that belongs to an order not available in the LIS, you can add the order
to the database manually. You must do this before you process the slide. Otherwise the analyzer
uses the default analysis settings for processing.

You can specify what type of analysis you want the analyzer to perform on the slide, and enter
patient and order information. The slide can then be processed on any of the analyzers connected to
the database with the analysis settings you specified.

Orders that you add manually are listed in the Database View on the Pending Orders tab where
they wait for processing. When an order is processed, it is moved to the list on Processed Orders
tab.

To add an order to the Pending Orders list

1. In the Database View, on the Pending Orders tab, click Add .

2. Inthe Order Data dialog, enter the Order ID exactly as it's labeled on the slide.
3. Under Type of order, specify the types of analyses you want to perform.

4. If the order is an emergency sample, select STAT.

5. Enter other needed details for the order.

Note: The Number of WBCs to count can be set to a maximum of 1000.
6. To add the order to the Pending Orders list, click Add.
7. Click Close.

8. Process the slides as instructed in 2.3 Process slides on page 26.

2.3.3 Stop slide processing

You can stop slide processing at any time, for example if you need to turn off the analyzer or process

an emergency sample. In that case images and results are discarded and an icon " is displayed in
the Processed Orders list. You can reprocess the slide using the same Slide ID.
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2 Operating procedure
To stop slide processing

1. In the System Control View E click Stop ™ .

2. When you receive the Do you want to stop the slide processing? message, click Yes.
The analyzer moves the slide to the input hatch and the status light flashes green.

©
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3. Open the input hatch and remove the slide.
The status light is now steady green indicating that the analyzer is in idle mode.

If you stop the slide processing or restart the analyzer, you must manually resume slide processing
under System control. To resume, click Start > .
2.3.4 Slide processing fail due to a mechanical error

If slide processing fails due to a mechanical error, the status light flashes red. Restart the
CellaVision DM Software. If the startup test fails, the status light flashes red again. For more
information, contact your local vendor’s technical support.

o,

32 PM-10895-01
Revised: 2021-10-31



2 Operating procedure I

2.3.5 View processing status

The System Control View is used to process orders.

In the System Control View, under Analysis log, you can view status information on the processed
slides. You can clear the log from all information.

In the System Control View you can also view information on analysis progress, latest found cells,
and the number of WBCs, non-WBCs and RBCs from the processed orders.

NEW ANALYSIS Analysis progress 1 53 o)) —]
Count %  x10e9/L
iaap [scri23e ot i 5 ottota 200 S
Etimted i It 329 minstes 10 526 comm—
e — + Basoph I
First name - 8 421 oomm ]

wm || oo

Female

Ordering physician

Patient comment

Non-WBC Count Ratio
+ Nudeated RBC 153
* Giant thrombocyte T
« Thrombocyte aggregation -
* Smudge cell 4 21
WBC count (x10ea/1) | 0.00 o Artefact 153

Type of analysis | WEC
RBC
PT

Number of WBCs to count | 200

RBC conc, (10e12/) | 0,00

Sampledate | 2020 || 04 | 14

STATslide

©O=-0

Analysis log

Latest found cells

1 System Control View 5 Analysis log
2 Analysis status 6 Clearlog

3 Autostart or resume slide processing

4 Stop slide processing

Related topics
» For more information on buttons, icons and indicators in the System Control View, see:

o 8.1 System Control View on page 109

o 8.2 Slide status on page 109

© 8.3 PPA status on page 110

2.3.6 View the usage log

The analyzer continuously saves data about its activity. To view the log, select Tools and then View
log.
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I 2 Operating procedure

Legfile Viewer X

Statistics Specffication Audit Trail

Time Operation User
20071106 10:24:30 Logged on instrument EmulDM3600 admin
200171106 10:24:30 Logon admin
20071102 151707 Logged off instrument EmulDM3600 admin
20171102 151707 Logoff admin

20071101 14:34:1 Settings-»PB Reference Cells->Added custom refe...  admin
200171101 14:34:05 Settings-»PB Reference Cells->Added custom refe...  admin
20071101 13:14:41 Opened arder 2078824 admin

Year: | 2017 | Month: |11 Operation: Lser: | Lpdate |

oK Cancel

You can access the Audit Trail tab only with access levels Administrator or Service. The Audit Trail
tab contains a list of any user activity on a slide or a changed setting. You can search for entries in
the Audit Trail tab by Year, Month, Operation and User. Enter text in the desired text box and click
Update.

You can access the Specification tab only with access levels Administrator or Service. The
Specification tab contains a list of analyzer events with dates and times, for example start and
completion of slide processing and hardware malfunctions.

The Statistics tab contains dates and times for program installations and for creation and
modification of the usage log. It also shows the number of successfully processed and failed slides,
the number of signed analyses, and the total processing time.
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Related topics

« For more information on user access levels, see 4.2.2 User access levels on page 56.

2.4 Use pay-per-analysis

If you use pay-per-analysis (PPA) with your analyzer, you must have a valid PPA smart card in the
connected smart card reader to process slides. The PPA smart card status is shown on the toolbar.

When properly connected, the Smart card connected icon i is displayed together with the
balance remaining on the card.

Balance withdrawal is done automatically from the PPA smart card when the analysis is successfully
performed and before the results are sent. With digital scans, the balance withdrawal is done when
the scan is completed. An analysis is considered successful if:

* No mechanical failure occured
» Analysis wasn't stopped manually
e Ordered cells were found

If the analysis is unsuccessful or if you run QC-labelled slides, no balance is withdrawn from the PPA
card. To avoid extra cost, we recommend that the service personnel also run QC-labelled slides
during installation and maintenance.

To use pay-per-analysis

1. Insert the PPA smart card into the smart card reader that is connected to your analyzer.

Note: The PPA smart card must be in the smart card reader during the entire analysis, and you
need to have at least one analysis remaining on your PPA card.

2. Process the slide as described in 2.3 Process slides on page 26.

2.5 Scan slides for digital images

If you're logged on to a scan database, you can scan a slide to generate digital images. You can use
the digital overview images to find cells and other objects of interest in the sample. You can change
the scan area and resolution before you start the scan.

0 Important!

A digital image provides a general overview of the prepared slide within the intended use
of the application. All other use is for research use only and not for use in diagnostic
procedures.

Related topics

» For more information on how to set up a scan database, see 4.1 Database settings on page 47.

PM-10895-01 35
Revised: 2021-10-31



I 2 Operating procedure

2.5.1 Scan slides

1.

2.

8.

Start the CellaVision DM Software and log on to a scan database.

Use the correct type of slide as specified in 7.3.1 Slides on page 104.
You can use cover slips if the total thickness of the slide and the cover slip is within specifications.
If you use cover slips, make sure that the scan area is within the cover slip area.

Open the input hatch and place the slide, with the blood smear facing up, in the loading tray.

In the System Control View H click in the Slide ID text box.

NEW ANALYSIS
Slide ID

Note: You can also use an optional barcode reader to read the barcode on the slide.

In the Enter Slide ID dialog, enter the Slide ID exactly as written on the slide.

Enter Slide 1D >

Slide 1D:

oK Cancel

Click OK.

Hold the tip of the oil bottle close to the slide without touching it, aim for the red colored marker,
and place three drops of the immersion oil on the slide.

Note: More oil is required when you scan a slide, so we recommend three drops of oil.

0 Important!
Use only CellaVision® immersion oil with the analyzer. Make sure that there are no air
bubbles present in the oil as they can interfere with slide processing.

Warning!
Avoid getting immersion oil on your skin. Wear protective gloves before you handle the

oil, slides, or other parts that can come into contact with the oil. Immersion oil can
cause skin sensitization. If you get oil on your skin, clean it off with soap and water.

Close the input hatch.
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2 Operating procedure I

9. To start processing the slide, in the System Control ViewE, click Start ™ .
The status light is steady yellow while the analyzer processes the slide.

- ©
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0.

10. Wait for the processing to finish. This takes a couple of minutes.
The status light flashes green when the processing is complete.

©
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Note: If an issue occurs during slide processing, you receive a warning with information about
the issue.

11. Open the input hatch and remove the slide. The status light is steady green indicating that the
analyzer is in idle mode.

Related topics
e For more information on what types of slides to use, see 7.3.1 Slides on page 104.

« For more information on how to change the scan area and resolution, see 4.9 Scan settings on
page 70.
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I 2 Operating procedure
2.6 Turn off the analyzer

Q Caution!
Always exit the CellaVision DM Software before you restart or turn off the analyzer. If your

turn off the analyzer abruptly, for example, break the power supply or press and hold the
stand-by button, the database may become corrupt.

1. Wait for the slide to be processed or stop slide processing manually.
For more information, see 2.3.3 Stop slide processing on page 31.

2. On the File menu, click Exit.

3. Click Start E select Power, and then select Shut down.

IS

. Press the Stand-by button the analyzer.

Note: Make sure that the input hatch is closed when the analyzer is not in use.
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3 QUALITY CONTROL PROCEDURE (QC)

The quality control procedure is a cell location test to validate the slide preparation process and
verify the ability of the analyzer to locate cells. The quality of the slide and sample must be good
enough for the analyzer to locate the cells and do the analysis.

3.1 Cell location test for peripheral blood

0 Important!

Cell location test helps to prevent misleading results caused by the analyzer failing to
locate nucleated cells. Run a cell location test at least once a day and after any changes in
the staining procedure or staining solutions. We recommend that you run the cell location
test even more often with analyzers that have a heavy work load.

When you run a cell location test, the analyzer first tries to locate a monolayer on a peripheral blood
slide and then locate 200 WBCs in that monolayer. Once the test is run, you can see an overview
image with the located cells marked.

To verify that the analyzer located all nucleated cells, you must examine the overview image and
count any cells that were not located. Based on your count, the analyzer then calculates the
percentage of located nucleated cells.

3.1.1 Prepare and process cell location slides

1. Use a freshly stained slide from a blood sample with a normal WBC count.
Note the following:

» Prepare the slide in the same way as a normal slide, and according to your laboratory's
procedure and 2.2 Prepare slides on page 24.

« We recommend that the WBC count is higher than 7 x 109/L. If the concentration is lower, the
test takes more time.

e The analyzer must locate at least 100 nucleated cells on the slide. Otherwise, the test result is
discarded.

» The percentage of non-nucleated cells must be below 50% of the total number of objects on
the slide.
Non-nucleated cells are objects that the analyzer doesn't pre-classify as WBCs or NRBCs, for
example smudge cells.
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I 3 Quality control procedure (QC)

2. Open the input hatch and place the slide, with the blood smear facing up, in the loading tray.

0 Important!

Make sure that the labeled or frosted end of the slide is on the right. If the slide is
placed any other way, the analyzer might scan a bad part of the smear. This can cause
unreliable results.

Note: If you use the optional barcode reader, your slides must be equipped with barcode labels
that begin with “QC". These are available from your local vendor.

3. In the System Control View E click in the Slide ID text box.

NEW ANALYSIS
Slide ID

4. In the Enter Slide ID dialog, enter QC and then the Slide ID exactly as written on the slide.

Enter Slide ID >

Slide 1D

oK Cancel

5. Click OK.

6. Hold the tip of the oil bottle close to the slide without touching it, aim for the red colored marker,
and place two drops of the immersion oil on the slide.

0 Important!
Use only CellaVision® immersion oil with the analyzer. Make sure that there are no air
bubbles present in the oil as they can interfere with slide processing.

Warning!
Avoid getting immersion oil on your skin. Wear protective gloves before you handle the

oil, slides, or other parts that can come into contact with the oil. Immersion oil can
cause skin sensitization. If you get oil on your skin, clean it off with soap and water.

7. Close the input hatch.

40 PM-10895-01
Revised: 2021-10-31



3 Quality control procedure (QC) I

8. To start processing the slide, in the System Control ViewE, click Start ™ .
The status light is steady yellow while the analyzer processes the slide.
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9. Wait for the processing to finish. This takes a couple of minutes.
The status light flashes green when the processing is complete.
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Note: If an issue occurs during slide processing, you receive a warning with information about
the issue.

10. Open the input hatch and remove the slide. The status light is steady green indicating that the
analyzer is in idle mode.

11. When the slide is processed, examine it as described in 3.1.2 Examine images from cell location
slides below.

3.1.2 Examine images from cell location slides

1. On the Tools menu, click Cell location.

2. Inthe Cell location slides list, click the cell location slide that you want to examine.
CellaVision DM Software opens the first image from that slide.
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3. Inthe overview image, count all nucleated cells that the analyzer didn't locate, and enter the
number in the WBCs + NRBCs missed text box.

Note: The analyzer located a cell if it's marked with a green, blue, or black box. For more
information on cell location markings, see 3.1.6 Identify cell location markings on page 44.

Example: located Example: located Example: not located

|Z|‘ : .Q  :.

4. To show the next image on the slide and repeat the count of non-located cells, click Next ﬂ

5. When you have examined all the images on the slide, the analyzer automatically calculates the
results of the cell location test.
The result is shown under Total result as Ratio of WBCs + NRBCs found.

6. When you have examined the slide, evaluate the result as described in 3.1.3 Evaluate cell location

test results below.

Note: An overview image consists of 4x4 sub-images. When the analyzer has found the required
number of objects, the image collection stops. This can give the last overview image a cropped
appearance.

As a general rule, the analyzer saves the cell location test results with related images for five days,
and then deletes them. The analyzer always saves the three most recent cell location test results
with related images even if they are older than five days. To review a saved test, click the slide ID in
the Cell location slides list.

The analyzer keeps track of all run cell location tests. To view a chart of the 30 latest results, click
Show History.

3.1.3 Evaluate cell location test results

Note: If your blood sample has a normal WBC count (7x109/L to 11x109/L), the analyzer needs 20 to
80 overview images to find the required number of objects. If the analyzer needs fewer or more
images, this indicates poor slide preparation, and you may need to adjust the slide preparation
process.

1. Under Total result, check that the Ratio of WBCs + NRBCs found is within your laboratory's
established limits.

2. Click Show History.
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3. Check the Cell location history chart that shows the percentage of identified cells for any shifts
or trends that may indicate an issue that needs further review.

io0 % — — — — )y S S S e e e e e e e e e = =

0 Important!
Don't process any patient slides if the result of the cell location test isn't within your
laboratory's established limits.

When you have resolved all occurring cell location issues, run another cell location test. When the
result of the cell location test is within your laboratory's established limits, you can start
processing slides.

Related topics

e For more information on performance characteristics when using standardized staining and
smear preparation procedures, see 7.2.1 Performance specification for CellaVision Peripheral
Blood Application on page 99.

e For more information on how to resolve possible cell location issues, see 6.4 Cell location issues
with peripheral blood on page 81.

3.1.4 Print and sign QC results
You can print the QC result of a single cell location test for manual signing, or generate a report (.pdf)

with digitally signed cell location tests.

To print the result of a single cell location test for manual signing

Click Print result.

To generate a report with digitally signed cell location tests
1. Click Generate Report.

2. Select the desired date interval.

3. Click Generate Report.

4. Enter a name and select a location for the report file.

5. Click Save.
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3.1.5 Perform manual correction

If the analyzer incorrectly pre-classifies any objects as nucleated cells (that is, marks them with a
green box instead of a blue box, or vice versa), you can manually correct the total result. Don't
perform manual correction for objects marked with a black box as those are already excluded from

the calculation.

1. To calculate the correct number of WBCs and NRBCs, subtract the number of objects incorrectly
pre-classified as nucleated cells from the number of WBCs + NRBCs found shown under Total

result.

For example, if the analyzer locates 187 nucleated cells, but you identify 3 of them as non-
nucleated cells, the correct number of WBCs and NRBCs is 184 (187 - 3 = 184).

2. In the Manual correction text box, enter the correct number of WBCs + NRBCs.
The analyzer uses this number for the calculation.

3.1.6

Identify cell location markings

The purpose of the cell location test is that the analyzer locates each cell, not that it correctly pre-
classifies each cell. The color of the box indicates how the analyzer pre-classified the located object.
You can perform a manual correction for objects that the analyzer incorrectly pre-classified as
nucleated cells as described in 3.1.5 Perform manual correction above.

Example: green box

<
.

-

This object is located and pre-
classified as a nucleated cell.

44

Example: blue box

This object is located and pre-
classified as a non-nucleated
cell.

The object may be, for
example, a smudge cell.

Example: black box

o

This object is located but not
pre-classified.

The object is excluded from
the cell location test since
enough WBCs are already
located.
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3 Quality control procedure (QQC) I

The box isn't always centered over the cell. It may cover part of the cell or may even be completely
separate from the cell. As long as there is a box associated with a cell, you can consider it located.

Example: located Example: not located
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If a cell is near the edge of the overview image, click it to view it in a magnified image.

Example: located (box near the edge of the overview

image)
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Icons shown in the Cell location slides list:
VAl images on this slide are examined and the analyzer has located all nucleated cells.

<Al images on this slide are examined but the analyzer hasn't located all nucleated cells.
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I 3 Quality control procedure (QQC)

“ slide error that may be caused by failure in slide processing (for example if the analyzer couldn't
locate enough nucleated cells). For more information on the error, click the slide in the list. The
cause of the error is shown in the text box under Total result.

Icons shown in the Overview images list:

v This image is examined and the analyzer has located all nucleated cells.

 This image is examined but the analyzer hasn't located all nucleated cells.
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4 Settings I

4 SETTINGS

This section describes settings for processing slides and using the CellaVision DM Software.

0 Important!
Most settings that you can change in the software affect all analyzers and review stations
that use the same database.

These settings affect all analyzers and review stations that use the same database:
» Database settings

» Archiving settings

» User account settings

» Analysis settings, except PLT estimate factor
* Report settings

» Order signing settings

» Standard comment settings

» Reference cells settings

e LIS settings

» Digital slides settings

Depending on your access level, you may not have access to all settings. For more information, see
4.2.2 User access levels on page 56.

Note: Your service personnel may have disabled some settings.

4.1 Database settings

0 Important!
These settings apply only to your system so your changes won't affect other systems that
use the same database.

Note: To manage databases, you must start the CellaVision DM Software with administrator
privileges.
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1. On the File menu, click Exit.

2. If the software doesn't restart automatically, right-click the CellaVision DM Software icon on the
desktop, and select Run as administrator. For information on user name and password, see the IT
Configuration Guidelines or contact your local vendor.

Open file location

) Run as administrator L\@

Images and order data are stored in databases.

We recommend that you always keep a backup of your databases. If you use the archiving function
and your database is lost, you can't access orders in the archive anymore.

0 Important!
To prevent any data loss, always use the latest online backup script available at
www.cellavision.com.

For information on how to back up and restore databases, see the IT Configuration Guidelines or
contact your local vendor.

These database types are available:
» Processing database (Normal): used for slide processing.
» Scan database: used for digitized images scanned from slides.

» Export database: used for orders exported from other databases (can't be used for slide
processing).

A processing or scan database requires 20 GB of disk space and an export database requires 1 GB.

Note: Having many databases reduces system performance.

4.1.1 Manage databases

0 Important!
These settings apply only to your system so your changes won't affect other systems that
use the same database.

To view a list of databases and connections to databases
On the Tools menu, click Settings, and then click the Database tab.

The icons in the list have these meanings:

|
== Database on your system computer
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’ Connection to a database on a server or on another system computer

To create a new database

Note: When you create a new database, it inherits certain settings from the database you're
currently logged on to. Before you start processing slides, log on to the new database and make sure
that all settings are correct.

1. Onthe Tools menu, click Settings, and then click the Database tab.
2. Click Create.

3. Inthe Create a database dialog box, in the Database name text box, enter a name for the new
database.

4. In the Description text box, you can enter a descriptive text for the new database.

5. In the Home directory box, enter the location where you want the new database to be stored.
You can also click browse (...) and browse for a location.

Note: You can create a database only on the local hard drive.
6. Under Type of database, choose a database type for the new database.

7. Click Create.

To delete a database

1. Onthe Tools menu, click Settings, and then click the Database tab.
2. In the Database list, click the database you want to delete.

3. Click Delete.

To connect to a database
1. Onthe Tools menu, click Settings, and then click the Database tab.
2. Click Connect.

3. Inthe Connect to a database dialog box, in the Database name text box, enter the name of the
remote database.

4. In the Description text box, you can enter a descriptive text for the remote database.

5. In the Remote computer box, enter the name of the computer where the remote database is
located.
If you don't know the name of the remote computer, on the server or the system computer
where the remote database is located, start the CellaVision Server Software or the
CellaVision DM Software, and then, on the Help menu, click System information.

6. Click OK.
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I 4 Settings

If the server or the system computer where the database is located is behind a firewall, you must
configure the firewall to allow other clients to connect to the database. Make sure that these ports
are open in the firewall:

* 1360 (Mimer SQL)

e 40201 (CellaVision DM Software Service)

To disconnect from a database
1. On the Tools menu, click Settings, and then click the Database tab.
2. Inthe Database list, click the remote database that you want to disconnect from.

3. Click Disconnect.

4.1.2 Manage database size

0 Important!
These settings apply only to your system so your changes won't affect other systems that
use the same database.

0 Important!
Make sure that there is always free disk space available on the partition where the
database is stored. If that partition becomes full, you can't use the system anymore.

To keep the system operational, you need to keep the database from growing too large. That is, you
must remove images from the database at the same rate as new slides are processed.

To automatically remove images from the database, you can:
+ Let the system auto-delete signed orders (including images) after a specified time.
» Keep all signed orders but let the system move the images to an archive after a specified time.

We also recommend that you manually remove failed and old unsigned orders from the database at
regular intervals.

Consider these factors when you set up the system to automatically remove images from the
database:

» Number of slides processed (and added to the database) daily.
* Maximum allowed size for the database:

° 200 GB (approximately 15 000 peripheral blood slides) for a database located on a server that
runs the CellaVision Server Software.

° 20 GB (approximately 1500 peripheral blood slides) for a database located on a system
computer.
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For example, if you process 20 peripheral blood slides per day, it takes 65 days to reach the
maximum capacity of 1500 slides. So you should set up the system to auto-delete signed orders after
65 days.

If you need to save signed orders for a longer time, set up the system to archive orders instead of
deleting them.

When an order is archived, the related images are moved from the database to an archive. The
archive is typically stored on a server. You can still open and view archived orders.

Note: The archiving function is not a backup function.

We recommend that you always keep a backup of your databases. If you're using the archiving
function, and the database is lost, you can't access orders in the archive anymore.

0 Important!
To prevent any data loss, always use the latest online backup script available at
www.cellavision.com.

For information on how to back up and restore databases, see the IT Configuration Guidelines or
contact your local vendor.

You can protect individual orders from being auto-deleted or archived.
You can also manually export orders from the database.

If you at any time exceed the maximum capacity for the database, you need to compress the
database as described in 5.2.2 Compress databases on page 74.

To view the database size

On the Help menu, click System information.

To auto-delete signed orders
1. On the Tools menu, click Settings, and then click the Archiving/Auto-delete tab.

2. Inthe When signed orders are older than (days) text box, enter how many days you want to
keep the signed orders in the database before they are deleted.

3. Click Delete the orders.

To auto-delete unsigned orders
1. Onthe Tools menu, click Settings, and then click the Archiving/Auto-delete tab.
2. Select Automatically delete unsigned orders that are older than (days).

3. Enter how many days you want to keep the unsigned orders in the database before they are
deleted.
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To archive signed orders

1.

2.

On the Tools menu, click Settings and then click the Archiving/Auto-delete tab.

In the When signed orders are older than (days) box, enter how many days you want to keep
the images of signed orders in the database before they are moved to the archive.

Select Archive those orders to this location and, in the text box, enter a path to the disk or
server where you want to store the archived images.

The specified path must be accessible from the system computer or server where the database is
located.

Under Images to archive, choose what images and how many from each cell class you want to
save in the archive.

You can reduce the size of the archive by choosing to save fewer images in the archive (for
example, only 10 images per cell class). Here you can see which cell classes belong to each
category:

Peripheral blood cell images

Normal WBCs Abnormal WBCs Non-WBCs
Segmented neutrophils Band neutrophils Nucleated RBC
Eosinophils Promyelocytes Giant thrombocyte
Basophils Myelocytes Thrombocyte aggregation
Lymphocytes Metamyelocytes Megakaryocyte
Monocytes Immature eosinophils Smudge cell

Immature basophils Artefacts

Promonocytes User defined Non-WBCs

Prolymphocytes Other

Blast cells Not classed

Lymphocytes, variant forms
Reactive lymphocytes
Abnormal lymphocytes
Plasma cells

Large granular lymphocytes
Hairy cells

Sezary cells

User defined WBCs

To auto-delete digital slides

This setting is available when you're logged on to a scan database.

1.

On the Tools menu, click Settings, and then click the Auto-delete tab.

2. Select Automatically delete orders that are older than and, in the text box, enter how many

52

days you want to keep digital slides in the database.
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3. If you want to keep regions of interest, select For orders containing regions of interest, keep
the order data and the regions of interest.

The order data and the regions of interest are kept in the database, but the overview image is
deleted.

4.1.3 Dashboard statistics

The system continuously stores statistical data on processed and signed slides. You can access
various status and statistical data on analyzers and reviewers via the CellaVision Dashboard.

You can also turn off data collection and erase all stored statistics.

Note: Stored statistics contain no patient data.

To turn off data collection
1. On the Tools menu, click Settings, and then click the Database tab.

2. Clear the selection for Enable collection of data in order to see statistics in the CellaVision
Dashboard.

To erase all dashboard statistics

1. Onthe Tools menu, click Settings, and then click the Database tab.

2. Click Clear, and then click Yes.

4.2 User account settings

0 Important!
These settings apply to all systems that use the same database so your changes may affect
other systems.

You can create user accounts with different access levels for everyone who needs access to the
system. With existing users, you can change their access level, full name, password, and email
address but not their user name.

If a user account is not used, you can deactivate or delete it.

A user account is valid for the database on which it was created. A user can log on to the database
from any system or review station that has a connection to that database.

To create a new user account
1. Onthe Tools menu, click Settings, and then click the Users tab.
2. To open the User Information dialog box, click New.

3. Inthe User name text box, enter a unique user name for the new user.
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4. In the Full name text box, enter the name of the new user.
5. Inthe Password and the Password again text boxes, enter the same password for the new user.
6. In the Email text box, enter the email address of the new user.

7. To fetch user information for the new user from an active directory, in the Active Directory user
name text box, enter the user name the user has in the active directory, or click Search... to
search for the user among listed active directory users.

Note: You must be logged on to the domain to use the search function.
8. In the Access Level list, select the level of authorization you want to give to the new user.
9. Make sure that Account active is selected.
10. Click OK.
A user name and a password can:
» Contain only characters A-Z, a-z, and 0-9
 Start either with letters or numbers

You can't use these words as a user name: create, get, grant, if, in, is, local, of, on, or, out, select, set, sys,
sysadm, system, table, to, update, and user.

Description of different user access levels

User access

level Rights

Observer Can view images and results without locking the slide.

User Can review WBC, RBC, and PLT results but can't sign slides.

Authorized Can review WBC, RBC and PLT results, and sign slides and orders.
Restricted Has the same rights as the Authorized but with restricted database access.

For more information on database access for the restricted user, see 4.2.1
Options for restricted users on the facing page.

Administrator Has full access to the system.

Service Has full access to the system except for patient data and user settings.

For more detailed information on each user access level, see 4.2.2 User access levels on page 56

To edit a user account
1. On the Tools menu, click Settings, and then click the Users tab.
2. Select the user account you want to edit, and then click Edit.

3. In the User Information dialog box, make your changes, and then click OK.
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4 Settings I
To deactivate a user account

1. On the Tools menu, click Settings, and then click the Users tab.

2. Clear the check box selection next to the user account you want to deactivate.
To reactivate the user account, select the check box next to it.

To delete a user account
1. On the Tools menu, click Settings, and then click the Users tab.
2. Select the user account you want to delete, and then click Delete.

Note: You can't delete the user account of a user that has signed slides in the database. You can
only deactivate their user account.

Related topics

» For more detailed information on access levels, see 4.2.2 User access levels on the next page.

4.2.1 Options for restricted users

0 Important!
These settings apply to all systems that use the same database so your changes may affect
other systems.

By default, a user with access level Restricted can only view signed slides.

You can allow them to view unsigned slides, which means that they can also review results, and sign
slides and orders (as Authorized users) without having full access to the database.

You can also allow them to search for slides by patient ID, order ID, or both in the Database View.
But they can't search by any other criteria, such as patient name or ordering physician.

1. Onthe Tools menu, click Settings, and then click the Users tab.

2. Under Restricted, to allow the restricted user to:
+ find, open, and view unsigned slides, select View unsigned slides.
» search for slides by patient ID, select Search by Patient ID.
» search for slides by order ID, select Search by Order ID.

For more detailed information on restricted users, see 4.2.2 User access levels on the next page.
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| 4sectings

4.2.2 User access levels

Slide processing Observer

and verification User Restricted | Authorized | Administrator @ Service

Start slide o ([ ] o L ]
processing

Verify WBC pre- [ ] J J [
classification

Verify RBC pre- [ ] J J [
characterization

Estimate o ([ ([ ] ([ ] (]
platelets

Add comments

Add comments
to signed slides

Confirm cell o ) () () ([ )
counter results

Sign slides and J J J [ ]
orders

Send results to o ([ ] ([ ] (]
LIS

Send images via [ [ J J J [ ]
email

Exclude PLT o ([ ] ([ ] ([ (]
analysis

Exclude RBC o ([ ] ([ ] ([ (]
analysis

Mark orders for o () () () ([ )
pathology review

Mark pathology [ J J J [ ]
review as

finished

Add comments o ([ ] ([ ] o L ]
to pathology

review

Add WBC o o ]

reference cells
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4 Settings I

Database Observer User Restricted Authorized Administrator Service

Find orders o [ o1 L ] [ o
by order ID

Find orders [ ) () 02 ([ ) )
by patient ID

Find orders o [ L ] [
by patient
name

Find orders [ ] [ ] L
by ordering
physician

Find orders [ J [ ] L
by comment
text

Find orders (] [ (] [ o
by pathology
review status

Find orders { [ { [ J [
by other
properties

Mark orders () o o o
as STAT

Add, edit, [ { { [ [
and remove

pending

orders

Edit order (] [
data

Protect o o o
orders from

archiving and

auto-delete

Delete { (] [
unsigned

orders and

slides

1 Depending on settings.
2 Depending on settings.
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Database Observer User Restricted Authorized Administrator Service

Delete signed [ [

orders

Export [ ([ {

orders

Change order ] [

ID of orders

in export

database

Mark an o o (] (]

order for

CellaVision

Transfer Tool

Change order J [

ID of orders

beginning

with “ER”

Maintenance Observer | User @ Restricted | Authorized @ Administrator | Service

Export log files [ ] L [ ] [ ] [ ] L

View log: Audit [ J

trail

View [ ()

log: Specification

Perform cell o o o

location tests

Prime oil o o (] o
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e Setings ||

Analysis

. Observer User | Restricted @ Authorized Administrator | Service
settings

Change default [ ] [ ] (]
processing
settings

Change re- [ [
classifications
settings

Change report [ [
settings

Change standard [ [ [
comments

Enable RBC pre- { ()
characterization

Change RBC [ [
grading and size

limits

Change intervals [ [
for PLT

concentration
levels

Set PLT estimate o (]
factor

Set manual PLT () ( [} ( o
concentration
estimation

Change default J [ [ [
scan area
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General

. Observer User Restricted Authorized Administrator Service
settings

Change email [ ] [ ]
settings

Change order [ ] [ ]
signing
settings

Change user [
accounts

Change J [ [ ]
worklist
settings

Compress ([ (]
database

Configure [ [
auto-delete
and archiving

Create o o
databases

Connect to o o
databases

Enable [ ® () )
audible

alarm

(optional)

Enable LIS ® o

4.3 Analysis settings

0 Important!
These settings apply to all systems that use the same database so your changes may affect
other systems.

4.3.1 Default processing settings

0 Important!
These settings apply to all systems that use the same database so your changes may affect
other systems.
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You can set the default processing values to specify how the system should process a slide if the
order ID isn't available in the database (in the Pending orders list) or from the LIS.

To set the default values for peripheral blood analysis

Note: These values are used only to process new slides that the system can't find in the LIS or in the
Pending orders list.

1. Onthe Tools menu, click Settings, and then click the Analysis tab.

2. Under PB default values, in the Number of WBCs to count text box, enter the number of
WBCs you want the system to locate.

Note: The Number of WBCs to count can be set to a maximum of 1000.
3. Under Type of order, select the types of analyses you want to perform on the slide.

4. If you want to, you can select the worklist items as specified in 4.3.3 Worklist settings on the next
page.

To set the default values for image scan

Note: These values are used only to process slides that the system can't find in the Pending orders
list.

1. Make sure you are logged on to a scan database.
2. Onthe Tools menu, click Settings, and then click the Analysis tab.

3. Under Scan default values, select a resolution for the scan images.

4.3.2 LIS settings

G Important!
These settings apply to all systems that use the same database so your changes may affect
other systems.

You can enable the analyzer to interact with the LIS. Once enabled, the analyzer retrieves order data
from the LIS and sends results back to the LIS. Before you enable the interaction, you must set up
the connection to the LIS as described in the IT Configuration Guidelines. For more information on
the LIS interaction, see the LIS Interface Manual.

To enable interaction with the LIS
1. On the Tools menu, click Settings, and then click the Analysis tab.
2. Select Enable LIS.

3. Restart the CellaVision DM Software.
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4.3.3 Worklist settings

Important!

0 These settings apply to all systems that use the same database so your changes may affect
other systems.

You can set the analyzer to automatically add processed peripheral blood slides to the worklist for all
logged on users as soon as the slides are processed.

If the network is slow, you can also set the analyzer to preload manually added slides to the worklist
in the background. These slides are locked for other users.

To add slides automatically to the worklist

Note: This feature is intended for a single analyzer setup. We recommend that you don't use this
feature with the CellaVision Server Software.

1. On the Tools menu, click Settings, and then click the Analysis tab.

2. Select Add processed slide to worklist.

To preload and lock slides added manually to the worklist
1. Onthe Tools menu, click Settings and then click the Analysis tab.

2. Select Preload and lock slides that | add to worklist.

4.3.4 PB re-classification settings

Important!

0 These settings apply to all systems that use the same database so your changes may affect
other systems.

You can set the analyzer to automatically forward cells of certain classes or types to other specific
cell classes or types after pre-classification or pre-characterization.

To set the analyzer to forward WBCs

1. On the Tools menu, click Settings, and then click the PB Re-classification tab.

2. Under Forward pre-classified cells, select the cell classes you want the analyzer to
automatically forward.

4.3.5 RBC pre-characterization settings

0 Important!
These settings apply to all systems that use the same database so your changes may affect
other systems.
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The analyzer can automatically pre-characterize and grade the RBC morphology of a sample. You can
change the grading limits the analyzer uses for automatic grading, and the size limits that the
analyzer uses to determine if a cell is a microcyte, a macrocyte, or a normal sized cell.

0 Important!

Make sure you use the same grading limits throughout your network for all equivalent
morphologies. If slides are processed on analyzers in your network that have different
grading limits, the limits will differ between the slides.

CellaVision® DC-1 uses the same method to measure anisocytosis as the optional CellaVision
Advanced RBC Application. This methods is called Anisocytosis (CV). Make sure to set the grading
limits appropriately for Anisocytosis (CV) in the CellaVision DM Software on your analyzer.

0 Important!

The method used to measure anisocytosis in other types of analyzers in your network that
use standard RBC (no CellaVision Advanced RBC Application installed) is called
Anisocytosis. Make sure to understand the difference between this method and
Anisocytosis (CV) when grading and reviewing samples.

To enable RBC pre-characterization

1. Onthe Tools menu, click Settings.
2. Click the RBC Pre-characterization tab.

3. Select Enable RBC pre-characterization.

To change RBC grading and size limits

0 Important!
You need to set your own RBC limits according to your laboratory's policy.

0 Important!

If your analyzer is connected to an existing database, settings are fetched automatically
from that database. This may not apply if the analyzer is connected to a database that is
also connected to analyzers that run additional CellaVision® applications. In that case,
check the RBC Pre-characterization tab to ensure that all values are entered.

1. On the Tools menu, click Settings, and then click the RBC Pre-characterization tab.
2. Click RBC Limits.

3. Under Grading limits (%), enter the grading limits (in percentage) for grades 1, 2, and 3 for each
RBC type.
By default, the grading limits are set to 0 (zero).

PM-10895-01 63
Revised: 2021-10-31



4. Under Size limits (micrometers), enter the smallest and largest size (in micrometers) for a cell
to be regarded as normal.

Smaller cells are regarded as microcytes and larger cells as macrocytes.

4.3.6 PLT settings

For the platelet estimation, the analyzer captures an overview image of the RBC monolayer.

Depending on the software configuration, you can use one of these methods to calculate platelet
concentration:

» Count platelets in one part (grid square) of the overview image at a time and enter the number of
platelets for each grid square.

» Estimate an average number of platelets per grid square.
* Manually estimate platelet concentration.

If you want to count platelets, you need to specify the intervals where you consider PLT
concentration to be significantly decreased, decreased, normal, or increased. You also need to
determine and enter a PLT estimate factor.

You can also change the default properties for the PLT view, such as grid size and how to calculate
and report PLT concentration.

0 Important!
You must determine and enter a PLT estimate factor before it's possible to calculate PLT
concentration. By default, the PLT estimate factor is set to 0.

To set manual PLT concentration estimation

0 Important!
These settings apply to all systems that use the same database so your changes may affect
other systems.

This setting applies to all slides in an order once one of them is opened for the first time. Once a
slide has been opened, this setting can't be changed for any slides in that order.

1. Onthe Tools menu, click Settings and then click the PLT tab.

2. Select Use only manual PLT concentration estimation.

To change the intervals for PLT concentration levels

0 Important!
These settings apply to all systems that use the same database so your changes may affect
other systems.
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. On the Tools menu, click Settings, and then click the PLT tab.

Under Intervals for average PLTs/HPF value, enter values where you consider PLT
concentration to be:

Significantly decreased

Decreased

Normal

Increased

To change the default properties for the PLT view

0 Important!
These settings apply to all systems that use the same database so your changes may affect

other systems.

These settings specify how the PLT view looks and functions. You can change any of these values
temporarily in the PLT view when performing the review.

1.

2.

On the Tools menu, click Settings, and then click the PLT tab.
In the Grid size drop-down, select how many grid squares you want to divide the PLT image into.
In the PLT count drop-down, select if you want to count or approximate the number of PLTs.

» Count PLTs per grid square allows you to enter the number of PLTs for each grid square
separately.

» Approximate PLTs per grid square allows you to approximate the number of PLTs per grid
square, and then enter the average number of PLTs per grid square.

In the PLT concentration drop-down, select how you want to report the PLT concentration.

» Calculated estimate reports the calculated number of PLTs per litre based on the counted or
estimated number of PLTs per grid square.

» Calculated level reports the calculated level of PLT concentration (increased, normal, and so
on) based on the counted or estimated number of PLTs per grid square.

» Manual level allows you choose the level of PLT concentration (increased, normal, and so on)
manually.

To calculate and set the PLT estimate factor

0 Important!
These settings apply only to your system so your changes won't affect other systems that

use the same database.
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1. Use a cell counter to perform automated PLT counts on 30 consecutive blood samples.
2. Prepare and stain one smear from each sample.
3. Process the slides with the analyzer.

4. With each slide, count and enter the number of PLTs in each grid square.

This way you perform the PLT analysis on each processed slide and let the software calculate the
average PLTs/HPF value for them.

5. Calculate the conversion factor for each sample: divide the PLT value from the cell counter by the
average PLTs/HPF value from the analyzer.

6. Calculate the PLT estimate factor (the average conversion factor): add the conversion factor for
each sample and divide it by 30.

7. On the Tools menu, click Settings, and then click the PLT tab.

8. Inthe PLT estimate factor text box, enter the calculated PLT estimate factor.
By default, the PLT estimate factor is set to O (zero).

4.4 Report settings

0 Important!
These settings apply to all systems that use the same database so your changes may affect
other systems.

You can change the default content and appearance of the report that the system generates when
you sign a slide. Choose one of the report templates that are delivered with the system or modify or
create your own report templates.

To set a default report template
1. Onthe Tools menu, click Settings and then click the Report/Sign tab.
2. Inthe Report template list, click the template you want to use, and then click Set active.

3. The arrow (- ) in the Name column now points to the report template you have set as the
default report template.

4. If you want to preview the report template, click the template in the Report template list and
then click Edit.

To edit a report template

1. Onthe Tools menu, click Settings and then click the Report/Sign tab.

2. Inthe Report template list, click the template you want to edit, and then click Edit.
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3. In the Add/Edit report template window, modify the report template as needed. Don't change
the text variables, that is the text surrounded by % (for example %AnalysisLabld%).

4. When you're done with the report template, click OK.

To create or import a new report template
1. On the Tools menu, click Settings and then click the Report/Sign tab.

2. If you want to create a new report template based on an existing report template, click that
template in the Report template list.

3. Click Add, and then click Yes or No depending on if you want to use an existing template or not.
4. Create your new template or click Import from file to import a template from a text file.

5. When you're done with the report template, click OK.

To remove a template

1. Onthe Tools menu, click Settings and then click the Report/Sign tab.

2. Inthe Report template list, click the template you want to remove and then click Delete.

4.5 Order signing settings

0 Important!
These settings apply to all systems that use the same database so your changes may affect
other systems.

You can change what is filled in by default in the Sign slide dialog box when it opens.

To change the default values for the sign slide dialog
1. On the Tools menu, click Settings and then click the Report/Sign tab.

2. Under Default settings for sign dialogs, choose how you want the Sign slide dialog box to be
set up by default.

4.6 Standard comment settings

0 Important!
These settings apply to all systems that use the same database so your changes may affect
other systems.

You can create standard comments that you can add to any of the analyses (WBC, RBC, or PLT). You
need to assign a unique identifier (code) to each standard comment, and you can choose if you want
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the analyzer to include that code in the comment or not.

To add a new standard comment

1. On the Tools menu, click Settings, and then click the Standard Comments tab.
2. Click New.

3. Inthe Code text box, enter a unique code to identify the comment.

4. Under Comment type, select the type of analysis you want to use the comment for, or click
General to use the comment for any analysis.

5. Inthe Comment text box, enter your comment text.
6. Click OK.
7. If you want the code to be inserted before the comment text, select Include code in comment.

8. If you want to see the list of standard comments in the comments dialog box, select Always
show expanded.

To edit a standard comment
1. On the Tools menu, click Settings, and then click the Standard Comments tab.

2. Inthelist, click the comment you want to edit, and then click Modify.

To delete a standard comment

1. On the Tools menu, click Settings, and then click the Standard Comments tab.

2. Inthelist, click the comment you want to delete, and then click Delete.

4.7 Reference cell settings

0 Important!
These settings apply to all systems that use the same database so your changes may affect
other systems.

You can save a WBC or a non-WBC as a reference cell on the WBC tab when you review a processed
PB slide.

You can also add an image from your computer as a reference cell.

To add a custom reference cell when reviewing a processed slide
1. Right-click the cell image and select Save as custom ref. cell.

2. Restart the CellaVision DM Software.
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To add a custom reference cell from your computer
1. On the Tools menu, click Settings.
2. Click the PB Reference Cells tab or the BF Reference Cells tab.

3. Inthelist of cell classes, click the cell class that you want to add reference cells to.

4. Click Add, locate the image you want to add as a reference cell, and then click Open.

You can add 24-bit .omp images or .jpg images. The added reference cell appears in the Preview
frame.

5. If you want to add a comment to the reference cell, click Comment.

6. Restart the CellaVision DM Software.

Settings *

E-Mail BF Reference Cells Repart/Sign Database Analysis REBC Pre-characterization BF Analysis Area
Users Language Archiving/Auto-delete PE Re-classification PLT PB Reference Cells Standard Comments

Band neutrophil Custom reference cells
Eosinophil

Basophil

Lymphocyte

Monocyte
Promyelocyte
Myelocyte
Metamyelocyte
Immature eosinophil
Immature basophil
Promonocyte
Prolymphocyte

Blast (no lineage spec)
Lymphocyte, variant form The reference cell
Flasma cell i f-'-«,’ | gallery will be updated

Large granular lymphocyte A | B & with an added or
! @ J e deleted cell only after
o the program has been

Hairy cell
restarted.

f—ry

LN B

Preview

Sezary cell

Cther

Nucleated RBC

Giant thrombocyte
Thrombocyte aggregation
Megakanyocyte

Smudge cell

Artefact

i

* Display name in use
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To delete a custom reference cell

—_

. On the Tools menu, click Settings.
2. Click the PB Reference Cells tab or the BF Reference Cells tab.
3. Inthelist of cell classes, click the cell class of the reference cell you want to delete.

4. In the Custom reference cells list, click the reference cell you want to delete, and then click
Delete.

5. Restart the CellaVision DM Software.

4.8 E-mail settings

0 Important!
These settings apply only to your system so your changes won't affect other systems that
use the same database.

You can set up your system to allow you to send WBCs and non-WBCs via e-mail.

To set up e-mail
1. On the Tools menu, click Settings, and then click the E-Mail tab.

2. Inthe Default recipient text box, enter an e-mail address for pre-selection.
You can always change this address before sending the e-mail.

Note: Make sure the default recipient e-mail address belongs to a user on the same domain as
your mail server.

3. Inthe Mail server text box, enter the address to the mail server you want to use.

4. In the E-mail from text box, enter the e-mail address that you want to appear as the sender of all
e-mails from the analyzer.

Note: These settings apply to everyone who uses this system, even those who use a different
user account or a different database.

4.9 Scan settings

0 Important!
These settings apply to all systems that use the same database so your changes may affect
other systems.

These settings are available only when you're logged on to a scan database.

You can change the default scan area and resolution for new orders that you add to the database (in
the Pending Orders list). The analyzer uses these values also to process a slide with an order ID that
is not in the database.
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4 Settings I

When you add a new order to the Pending Orders list, you can choose a different scan area and a
different resolution than the default. The greater the resolution, the bigger the file.

The maximum scan area depends on the selected resolution.

Resolution Maximum scan area

Low 14 x 45 mm
Medium 14 x 20 mm
High 10x 10 mm

To set the default resolution
1. Onthe Tools menu, click Settings, and then click the Analysis tab.

2. Under Scan default values, select the resolution you want you use.

To set the default position and scan area size
1. On the Tools menu, click Settings, and then click the Default Scan Area tab.
2. To define the scan area, do one of the following:

» Enter values in the text boxes to specify the scan area.

» Use your mouse to draw a rectangle on the slide. The rectangle must be within the red dotted
rectangle on the slide.

------

-

Use your mouse to draw a rectangle for the area you want to scan.

4.10Language settings

0 Important!
These settings apply only to your system so your changes won't affect other systems that
use the same database.
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| 4sectings

You can change the language for the CellaVision DM Software user interface and for the Instructions
for Use.

You can choose from languages that were installed during analyzer installation.

To change the language for the user interface
1. On the Tools menu, click Settings, and then click the Language tab.
2. Under Language for the user interface, choose a language from the list.

3. Restart the CellaVision DM Software.

To change the language for the Instructions for Use
1. On the Tools menu, click Settings, and then click the Language tab.
2. Under Language for the instructions for use, choose a language from the list.

3. Restart the CellaVision DM Software.
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5 MAINTENANCE

Warning!
Only trained personnel may perform service on this analyzer.

c Caution!
Be careful not to bend or put excessive force on any part of the analyzer interior.

5.1 Weekly maintenance

Performing these maintenance measures once a week, helps to ensure the analyzer's optimal
performance.

5.1.1 Restart the analyzer

c Caution!
Always exit the CellaVision DM Software before you restart or turn off the analyzer. If your
turn off the analyzer abruptly, for example, break the power supply or press and hold the
stand-by button, the database may become corrupt.

—_

. Wait for the slide processing to finish or stop it manually.
For more information, see 2.3.3 Stop slide processing on page 31.

2. Onthe File menu, click Exit.

3. Click Start E select Power, and then select Shut down.

4. Torestart the analyzer, see 2.1 Turn on the analyzer on page 23.

5.1.2 Delete unsigned orders

1. Click Database View .

2. Under Search criteria, in the drop-down list, select View unsigned, and then click Search for
orders.

3. Inthe Processed Orders list, select the orders you want to delete.

» To select a consecutive group of orders, click the first order, hold down Shift, and then click the
last order.

¢ To select non-consecutive orders, hold down Ctrl, and then click each order that you want to
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select.
4. Click Delete, and then click Yes.

You can also set to auto-delete unsigned orders. See 4.1.2 Manage database size on page 50.

5.1.3 Clean the analyzer

c Caution!
Use only a soft cloth moistened with water. Other solvents and sharp or abrasive cleaning
tools may cause damage to the analyzer.

1. Wipe the outer casing with a moist cloth.
2. Wipe any excess oil from the loading tray.

3. Pull out the drip tray and wipe clean of any immersion oil.

5.2 Remedial maintenance

5.2.1 Check and back up databases

To help prevent loss of data, back up your database at regular intervals. For information on how to
back up and restore the database, see the IT Configuration Guidelines or contact your local vendor.

To check database size
1. On the Help menu, click System Information.

2. Check the Database size.
Take steps to reduce database size if it's more than;

e 20000 MB for a local database.

* 200 000 MB for a remote database located on a server.

Related topics

* For more information on how to reduce database size, see 4.1.2 Manage database size on
page 50.

5.2.2 Compress databases

G Important!
These settings apply only to your system so your changes won't affect other systems that
use the same database.
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0 Important!

Make sure no users are logged on to the database you want to compress. This includes
users logged on via the CellaVision DM Software on other analyzers, via the
CellaVision Remote Review Software, or via the CellaVision Server Software.

When images are removed from the database (manually, by auto-delete, or by archiving), the
database still allocates the same amount of hard disk space. You can free this hard disk space, that is
actually reducing the size of the physical file where the data is stored, by compressing the database.

Compressing a database requires free disk space equal to the size of the database.

When a database is being compressed, no clients can use or connect to that database. This is why
you can't compress the database that you logged on to when you started the

CellaVision DM Software. Any users who are still connected to the database when you start the
compression receive an error message.

To compress a database
1. Make sure no users are logged on to the database you want to compress.
2. Start the CellaVision DM Software.

3. Log on to a database other than the one you want to compress with access level Administrator
or Service.

4. On the Tools menu, click Settings, and then click the Database tab.
5. Inthe Database list, click the database you want to compress, and then click Compress.

6. Inthe Compress database dialog, check that the value for Available on harddisk is the same or
bigger than Original size.

If the value for Available on harddisk is less than Original size, you need to free more disk
space before you compress the database.

7. Click Compress database.

Note: It may take a long time to compress a database. For example, a database larger than 10 GB
may take several hours to compress.
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6 Troubleshooting [ |

6 TROUBLESHOOTING

This section describes issues that may occur during operation, along with possible causes and
suggested solutions.

To investigate and resolve issues

1.

2.

Observe any unusual circumstances surrounding the issue.
Note any error messages displayed.
Follow the relevant troubleshooting steps.

If the issue persists, export the log files, and then contact your local vendor for assistance.
Note: Always export the log files before contacting your local vendor.

To export log files to folder

1.

2.

On the Tools menu, click Export Log Files.

Select Export to folder.

Select Compress files before export.

Enter or browse (...) to a location where you want to export the log file, and then click OK.

Click Export/Burn.

6.1 Connection issues

Issue Solution
Can't connect to the Restart the analyzer.
database.

Check your network connection.
Make sure that there is no firewall blocking the network port.

If the server or the system computer where the database is located is
behind a firewall, the firewall must be configured to allow other
clients to connect to the database. Make sure that port 1360 (Mimer
SQL) and port 40201 (CellaVision DM Software Service) are open in the
firewall.

Can't log on to the Check your user name and re-enter your password.

CellaVision DM Software.

Make sure that Caps lock is turned off.

Log on to the CellaVision DM Software as instructed in 2.1 Turn on the
analyzer on page 23.
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I 6 Troubleshooting
6.2 General processing issues

Image is blurry
Cause Solution
Not enough oil on the slide. 1. Wipe the slide clean from oil.

2. Hold the tip of the oil bottle close to the slide without
touching it, aim for the red colored marker, and place two
drops of the immersion oil on the slide. Check carefully for air

) . ) bubbles before processing the slide. Don't agitate or shake
Air bubbles in the oil. the oil bottle.

If the issue reoccurs, clean the objective lens as instructed in
6.12 Clean objective lens on page 92.

Slide not properly positioned Check the slide positioning and the size of the barcode as
during slide processing instructed in 7.3.2 Barcodes on page 105.

because the barcode label is

placed too close to the edge of

the slide.
Dust particles in the loading Wipe the loading tray with a lint free tissue to remove any dust
tray. particles. If the issue occurs on a regular basis, make this activity

as part of your daily or weekly maintenance.

WBC images are visible but not centered.

Cause Solution

Analyzer needs calibration or alignment. Contact your local vendor’s technical support.

/i Incomplete analysis

Less than the ordered number of cells are collected.

Cause Solution

Low WBC count in the Prepare and process more slides from the same sample.
sample.

Monolayer area found is Prepare the slides with longer blood smears.

too small.

Artefacts (staining Make sure that the reagents are changed according to the

precipitates) on the slide. recommendations in 2.2.3 Staining on page 26.
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6 Troubleshooting [ |

/% Incomplete analysis

No RBC/PLT image is saved.

Cause

Solution

Excessive amount of small artefacts | Make sure that the slides are prepared according to the
in the smear or too light a stain. recommendations in 2.2 Prepare slides on page 24.

/1. Analysis failure

Cause

No monolayer
found.

Slide is placed
incorrectly in the
loading tray.

Not enough oil on
the slide.

Air bubbles
present in the oil.

> Light error.

Cause

Smear is too dark or

Check your smear making procedure using the
CellaVision SmearChecker.

See also 6.6 Smear and staining issues on page 84.

Solution

Make sure that the slides are prepared according to the recommendations in
2.2 Prepare slides on page 24.

See also 6.6 Smear and staining issues on page 84.

Make sure that the slide is placed in the loading tray with the blood smear
facing up and that the labeled or frosted end of the slide is on the right.

1. Wipe the oil from the slide.

2. Hold the tip of the oil bottle close to the slide without touching it, aim for
the red colored marker, and place two drops of the immersion oil on the
slide.Check carefully for air bubbles before processing the slide. Don't
agitate or shake the oil bottle.

If the issue reoccurs, clean the objective lens as instructed in 6.12 Clean
objective lens on page 92.

Solution

Make sure that the slides are prepared according to the recommendations

too thick. in 2.2 Prepare slides on page 24.
Check your smear making procedure using the CellaVision SmearChecker.
See also 6.6 Smear and staining issues on page 84.
LED issue. Contact your local vendor’s technical support.
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I 6 Troubleshooting

Database access is slow.

Cause
Database service
needs to restart.
Database is too

large.

Database files are
fragmented.

Large network
delays.

Solution
If you use a local database service, restart the analyzer.
If you use the CellaVision Server Software, restart the server.

Keep the database size below the maximum allowed size as instructed in
5.2.1 Check and back up databases on page 74.

Compress the database as instructed in 5.2.2 Compress databases on
page 74.

Make sure that the network connections are stable.

Make sure that the network communication delays are small.

When scanning a slide, it gets status " Analysis failure" with additional information "No
image data in scanned area".

Cause Solution
Too little specimen on the slide. Prepare a slide with more specimen.
Wrong area selected on the slide. Select the correct area and reprocess the slide.

Same cell is counted more than once or duplicate cell images are shown.

Cause

Solution

Sample contains disintegrated cells or | To minimize the amount of disintegrated cells, make sure

smudge cells, and the analyzer the smear is prepared within four hours of blood
identifies different parts of a cell as collection. For more information, see 2.2.1 Prepare
two or more different cells. peripheral blood smears on page 25.

To minimize the amount of smudge cells, verify your
smear preparation process.

To identify and exclude duplicate cells, activate the Show
cell markers |G function during review.
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Cells are split into two or more parts.

Cause Solution
Too little You may need to increase fixation and staining time.
staining.

Check your smear making procedure using the CellaVision SmearChecker.

See also 6.6 Smear and staining issues on page 84.

Too much You may need to correct the rinsing technique so that it's adequate but not
rinsing. excessive.

Check your smear making procedure using the CellaVision SmearChecker.

See also 6.6 Smear and staining issues on page 84.

6.3 LIS error messages

Default values
The slides are analyzed with default values even though LIS is used for order information.

Cause Solution

Order is not in the LIS. Make sure that the order is available in the LIS.
Connection to the LIS is broken. Check the connection to the LIS.

LIS status:

Cause Solution

Connectiontothe LIS | Check the connection to the LIS. Results are automatically resent when
is broken. connection is re-established.

6.4 Cell location issues with peripheral blood

Too many non-nucleated cells in the sample.

Cause Solution
Too many smudge cells Run another slide from another patient. If the issue persists, check
found. your smear making procedure using the CellaVision SmearChecker.

Verify sample preparation procedure as instructed in 2.2.1 Prepare
peripheral blood smears on page 25.

Too many artefacts found. | Increase rinse time.
Filter the stain.
Make sure that the stain has not exceeded the expiration date.
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I 6 Troubleshooting

Too many non-nucleated cells in the sample.

Cause Solution
Cells are incorrectly Run another slide. If the issue persists, prepare new staining
classified as non- reagents.

nucleated cells.

Too few nucleated cells located in the sample.
Cause Solution
WBC count is low. | Prepare a new slide with a higher WBC count.

Smear is too Prepare longer smears.
short.

Smear is of poor  Verify sample preparation procedure as instructed in 2.2.1 Prepare peripheral
quality. blood smears on page 25.

Too many missed cells in the sample.

Cause Solution

WBC count is too high. Do not process slides with a WBC count higher than 100 x
109/L.

Staining is of poor quality. Verify your staining procedure. See also 2.2.3 Staining on
page 26.

Analyzer needs calibration or Contact your local vendor’s technical support.

alignment.

Processing time is long.
Cause Solution
WBC count is low. Prepare a new slide with a higher WBC count.

Staining is of poor quality. | Verify your staining procedure. See also 2.2.3 Staining on page 26.

Nearly all boxes are far from the cells.

Cause Solution
Positioning error. Contact your local vendor’s technical support.
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A cell is marked with more than one box.

Cause Solution

Too little staining. | You may need to increase fixation and staining time.

Too much rinsing. | You may need to correct the rinsing technique so that it's adequate but not
excessive.

The analyzer needs fewer than 20 or more than 80 overview images to find the required

number of objects.

Cause Solution

Smear is of poor quality. Verify sample preparation procedure as instructed in 2.2.1
Prepare peripheral blood smears on page 25.

Staining is of poor quality. Verify your staining procedure. See also 2.2.3 Staining on
page 26.

6.5 Barcode issues

Barcode is not read.

Cause Solution
Handheld barcode reader (optional) Make sure that the barcode reader cable is connected to
can't read the barcode. the analyzer.

In the System Control View, manually enter the Slide ID
exactly as written on the slide.

Quiet zone is missing. Make sure that a quiet zone is present as specified in
7.3.2 Barcodes on page 105.

Make sure that the barcode is not printed too close to a
logotype.

Contrast between the bars and the Adjust the printer.

background is too low. ) ) )
Use slides with a white, smooth, frosted area.

Print is of poor quality. Clean the printer head in the barcode printer.

Replace the printer ribbon in the barcode printer.
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Barcode is not read.
Cause Solution

Barcode is damaged (barcode cells are | Adjust the printer.

missing). ] ] ]
Use slides with a white, smooth, frosted area.
No barcode is found. Check the barcode positioning and size as instructed in
7.3.2 Barcodes on page 105.
Barcode is blurry because of Make sure the barcode is resistant to immersion oil.
immersion oil.

Print the barcode as instructed in 7.3.2 Barcodes on
page 105.

6.6 Smear and staining issues

Note: Check your smear making procedure using the CellaVision SmearChecker.
Note: Depending on the slide processing issue, images and preliminary results may still be available.
You need to assess if the smear quality is good enough to review the results.

/%, Smear Warning

Monolayer: Bad quality

Monolayer: Short or uneven

Cause Solution

Smear is of Verify sample preparation procedure as instructed in 2.2 Prepare slides on
poor quality. page 24.

Slide is Make sure that the slide is placed in the loading tray with the blood smear facing

placed up and that the labeled or frosted end of the slide is on the right.

incorrectly in

the loading

tray.

Not enough 1. Wipe the oil from the slide.

oil on the

slide. 2. Hold the tip of the oil bottle close to the slide without touching it, aim for the
red colored marker, and place two drops of the immersion oil on the
slide.Check carefully for air bubbles before processing the slide. Don't agitate

) ) or shake the oil bottle.
Air bubbles in
the oil. If the issue reoccurs, clean the objective lens as instructed in 6.12 Clean objective
lens on page 92.
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/1. Smear Warning

WBC distribution: Uneven

Cause Solution
Smear is of poor Verify sample preparation procedure as instructed in 2.2 Prepare slides on
quality. page 24.

/', Smear Warning

Smear: Too red/Too blue/Too light/Too dark/Too blue or too dark.

Cause Solution
Staining is of poor quality. Verify your staining procedure. See also 2.2.3 Staining on
page 26.

/. Smear Warning

=

All WBCs have collected in a limited area. The cell distribution may be distorted.

Cause Solution

WBC To get a more representative differential count, increase the number of
concentration is | ordered WBCs and reprocess the slide. This warning may persist even with
high. increased number of ordered WBCs.

The RBCs appear bright red or pale. Poor pre-classification of WBCs. Pale nucleus and/or
granula.

Cause Solution
Too little staining. You may need to increase fixation and staining time.
Too much rinsing. You may need to correct the rinsing technique so

that it's adequate but not excessive.

Stain, buffer or rinse used is too acidic. Check the pH of the buffer with a pH meter, and
adjust if needed.

Acidity of the stain or buffer is increased Use a new batch of stain or buffer.
due to exposure to acid fumes.
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The RBCs appear dark, the nuclear chromatin is deep blue or black and the granules of the
neutrophilic granulocytes are deeply overstained and appear large and prominent. The

granules of the eosinophils appear dark.
Cause

Too much staining.

Too little rinsing.

Stain or buffer is too alkaline.

Smear is too thick.

Solution

Decrease the fixation time.

You may need to decrease the amount of stain
(shorten the staining time) and increase the amount
of buffer (increase the stain/buffer time).

Increase rinse time.

Check the pH of the buffer with a pH meter, and
adjust if needed.

Prepare a thinner smear.

The RBCs pre-classified as artifacts, thrombocyte aggregation or WBCs.

Cause

Too much staining.

Too little rinsing.

Stain or buffer is too alkaline.

Smear is too thick.

Solution

Decrease the fixation time.

You may need to decrease the amount of stain
(shorten the staining time) and increase the amount
of buffer (increase the stain/buffer time).

Increase rinse time.

Check the pH of the buffer with a pH meter, and
adjust if needed.

Prepare a thinner smear.

Samples have dark areas of stain or other artefacts.

Cause

Smear was not completely dry when stained.

Solution

Make sure the smear is completely dry before

staining it.
Slide is dirty. Use clean slides.
Too little rinsing (not enough rinsing to remove Increase rinse steps.

the metallic scum).

Stain forms a precipitate in the solution.

Filter the stain.

Make sure that the stain has not exceeded the
expiration date.
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Same cell is counted more than once or duplicate cell images are shown.
Cause Solution

Sample contains disintegrated cells or | To minimize the amount of disintegrated cells, make sure

smudge cells, and the analyzer the smear is prepared within four hours of blood
identifies different parts of a cell as collection. For more information, see 2.2.1 Prepare
two or more different cells. peripheral blood smears on page 25.

To minimize the amount of smudge cells, verify your
smear preparation process.

To identify and exclude duplicate cells, enable Show cell
markers [&] during review.

Cells are split into two or more parts.

Cause Solution

Too little You may need to increase fixation and staining time.

staining.

Too much You may need to correct the rinsing technique so that it's adequate but not
rinsing. excessive.

6.7 General startup issues

Log on to system takes time.
Cause Solution

System computer not Restart the system computer.

restarted in over a week.
Restart the analyzer.

Database is too large. Keep the database size below the maximum allowed size as
instructed in 5.2.1 Check and back up databases on page 74.

Database files are Compress the database as instructed in 5.2.2 Compress databases on
fragmented. page 74.
Large network delays. Make sure that the network connections are stable.

Make sure that the network communication delays are small.
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6.8 Startup error messages

Could not log on to the system. Make sure you entered your user name and password
correctly.

Cause Solution

Wrong user name or password. Check your user name and re-enter your
password.

Caps lock is on. Turn off Caps lock.

Unable to contact the database host computer computer name. Check your network
connection and verify that the computer is turned on.

Cause Solution
Can't connect to local database service. Restart the analyzer.
Can't reach server that runs Check your network connection.

CellaVision Server Software. )
Make sure that the server is turned on and that the

CellaVision Server Software is running.
Restart the server.

Unable to connect to the database service. Make sure that the database service has not
been stopped and that the network port is not blocked by a firewall.

Cause Solution
Can't connect to local database service. Restart the analyzer.
Can't reach server that runs Check your network connection.

CellaVision Server Software. )
Make sure that the server is turned on and that the

CellaVision Server Software is running.
Restart the server.

Make sure that there is no firewall blocking the
network port.

For more information on what network ports are
used, see 5.2.2 Compress databases on page 74.
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There is not enough disk space on the drive where the database is located.

Cause Solution
Database is located on the C Move the database to the D drive.
drive.

Partition where the database is Reduce the database size as instructed in 4.1.2 Manage
located is full. database size on page 50.

The configuration of the system is incorrect.

Cause Solution
Analyzer has lost its To reconfigure the analyzer, contact your local vendor's technical
configuration. support.

Jam error occurred during initialization.

Cause Solution

Motor specified in the error Restart the CellaVision DM Software. If the error message re-
message reports a positioning occurs, contact your local vendor’s technical support.

failure.

Slide is in the wrong position. Open the input hatch and remove the slide.

Temperature is too high.

Cause Solution

Less than 20 cm Make sure there is enough free space around the analyzer for
clearance around the ventilation purposes.

analyzer.

Room temperature is too | Make sure the room temperature does not exceed the temperature
high. specified in 7.1.2 Environmental specification on page 97.

Air filter is dirty. Check the condition of the air filter. To replace the filter, contact your
local vendor's technical support.

Fan is defective. To replace the fan, contact your local vendor's technical support.

File system or registry failure.

Cause Solution
File system or registry is Reinstall the CellaVision DM Software as specified in its Installation
corrupt. Instructions.
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An unknown error occurred when archiving slides. One or more slides have not been
archived.

Cause Solution

One or more slides opened by another = Make sure that the slides are closed.

user.
Restart the server or the system computer where the

database is located.

An unknown error occurred when the system tried to autodelete old slides. One or more
slides could not be deleted.

Cause Solution
One or more slides opened by another Make sure that the slides are closed.
user.

Restart the server or the system computer where
the database is located.

Can’t open this order because the archive wasn’t found.
Cause Solution

Server or system computer where the database is Check the network connection.
located can't connect to the archive.

Archive files were moved to another location. Move the archive files back.

In the Archiving location text box, enter
the new path to the archive files.

6.9 Hardware error messages

Temperature is too high.

Cause Solution

Less than 20 cm Make sure there is enough free space around the analyzer for
clearance around the ventilation purposes.

analyzer.

Room temperature is too | Make sure the room temperature does not exceed the temperature
high. specified in 7.1.2 Environmental specification on page 97.

Air filter is dirty. Check the condition of the air filter. To replace the filter, contact your
local vendor's technical support.

Fan is defective. To replace the fan, contact your local vendor’s technical support.
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File system or registry failure.

Cause Solution
File system or registry is Reinstall the CellaVision DM Software as specified in its Installation
corrupt. Instructions.

Positioning failure.

Cause Solution

Motor specified in the error Restart the CellaVision DM Software. If the error message re-
message reports a positioning occurs, contact your local vendor's technical support.

failure.

6.10Slide processing error messages

No connection to the database service. Check your network connection and verify that
the service is running.

Cause Solution

Connection to database is lost. | If you see status No connection, wait up to a minute for the
connection to re-establish, and then re-start slide processing.

Check the network connection.
If you have a database on the analyzer, restart the analyzer.

If you use the CellaVision Server Software, restart the server.

There was a problem when accessing the database.

Cause Solution
Order ID contains non-ASClI Make sure that the order ID follows the specification in 7.3.2
characters. Barcodes on page 105.

Critical internal error during cell collection.

Cause Solution

Temporary software error. Restart the CellaVision DM Software.

Critical internal error.

Cause Solution
Temporary software error. Restart the CellaVision DM Software.
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6.11Slide processing issues

Status light flashes red.

Cause Solution

Motor Restart the CellaVision DM Software. If the error message occurs again, contact
positioning your local vendor’s technical support.

failure.

Analyzer doesn't process slides.

Cause Solution

Slide processing is stopped. Click Restart the slide processing » .
Input hatch is open. Close the input hatch.

PPA smart card is empty. Put a new PPA smart cart in the reader.
No PPA smart card in the reader , Put a PPA smart cart in the reader.

6.12Clean objective lens

Note: Always clean the objective lens gently and according to recommendations. It's sensitive and a
vital part for good quality analysis.

To clean the objective lens, you must remove the input hatch and hood.

Q Caution!
To help prevent damage to the analyzer, don't use excessive force when removing or
assembling the input hatch and the hood.

To remove the hood and the input hatch

1. On the Maintenance menu, click Open hood position.

2. Open the lid of the input hatch (1).
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3. Toremove the input hatch (1), pull it from the rear edge and up.

1 Input hatch
4. To open the hood (2), place a hand on the top of the cover and pull it up and forward.

5. Toremove the hood (2), pull it up.

2 Hood

Caution!
Be careful not to damage any cables or connectors when removing the hood.
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To clean the objective lens

c Caution!
To help prevent damage to the analyzer, don't use any detergents to clean the objective
lens.

1. With a new lens paper, gently wipe the 100x objective (3) lens.
Discard the lens paper after use.

3 100x objective
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To assemble the hood and the input hatch

1. To put back the hood (2), gently push it down until it snaps into place.

2 Hood
2. Close the hood (2).

3. Open the lid of the input hatch (1)

4. Angle the input hatch (1) and place the hooks (4), located in its front bottom, on the edge inside
of the casing side cover.
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5. Push down the input hatch (1) from the rear edge until it snaps into place.

1 Input hatch
4 Hooks

6. Close the input hatch (1).

7. Restart the CellaVision DM Software.

To verify functionality

1. Run a cell location test as instructed in 3 Quality control procedure (QC) on page 39.

2. If the cell location test fails or if the images are blurry, run a second cell location test.

3. If the second cell location test fails or if the images are blurry, restart the cleaning procedure.
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7 TECHNICAL INFORMATION

7.1 System specifications

7.1.1 Storage and handling specification

Specification Description
Storage temperature -10°C to 60°C
Relative humidity 20% to 80%, non-condensing

The analyzer delivery should be unpacked by trained personnel. We recommend saving the
packaging material for possible future transports.

Acclimatize the system to operating conditions for 24 hours before taking it into use. For
specifications of operating conditions, see 7.1.2 Environmental specification below.

7.1.2 Environmental specification

Specification Description

Temperature 18°Cto 31°C

Relative humidity 20% to 80%, non-condensing
Altitude Upto2000m

Other Indoor use only

7.1.3 Physical specification

Specification Description
Weight 11 kg
Width 280 mm
Depth 390 mm
Height 370 mm
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7.1.4 Electrical specification

Analyzer
Specification Description
Voltage input 12VDC
Current input 7 ADC

This system complies with the emission and immunity requirements described in the IEC 61326-2-
6:2012 (EN 61326-2-6:2013).

This system complies with the requirements described in the IEC 61010-2-101:2015 (EN 61010-2-
101:2017), IEC 61010-1:2010 (EN 61010-1: 2010), UL 61010-1 (3rd Edition, May 11, 2012, Revised July
15, 2015), CAN/CSA-C22.2 No. 61010-1-12 (3rd Edition, Revision dated July 2015)

Power supply cord, USA and Canada

Specification Description

Manufacturer Various

Type/Model UL Listed and CSA certified, min. type SV.
Technical Data Minimum 18 AWG

3 conductors, rated min. 60 °C

Provided with grounding-type (NEMA 6-15P) attachment plug, rated
125V ACor 250 VAC, min. 2.5A

Opposite end terminates in IEC 320 style connector, rated 125V AC or
250 VAC, min. 2.5A.

Standard UL62, UL498 or UL817
Required Marks or C-ULus or UL and CSA
Conformity
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Power supply cord, other countries

Specification Description

Manufacturer Various

Type/Model Cord type min. HO5RR-F or min. HO5VV-F or min. HO5VVH2-F
Technical Data 3x0.75 mm?2

Minimum 60 °C

Provided with grounding-type attachment plug, rated 250 V AC,
min. 2.5A

Opposite end terminates in IEC 320 style connector, rated 250 V AC,
min. 2.5 A

Standard Set: [EC60799.
Cord: IEC60245 or IEC 60227
Plug: IEC 60884

Required Marks or <HAR>
Conformity

7.1.5 Noise specification

The analyzer does not produce any hazardous noise levels.

7.1.6 Disposal specification

Specification Description
Oil bottle Dispose of contents/container according to local regulations.
Analyzer Contact your local vendor for information on how to dispose of the analyzer.

7.2 Performance specifications

7.2.1 Performance specification for CellaVision Peripheral
Blood Application

Average WBC cell-location and display of at least 97% with a standard deviation less than 2%.

Throughput!: Approximately 10 slides per hour for complete orders containing RBC, PLT, and 100
WBCs.

WBC comparison study

1 Depending on WBC concentration, number of non-WBCs, and smear quality.
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Comparison studies were conducted at 3 sites. The results from the CellaVision® DC-1 were
compared with the CellaVision Peripheral Blood Application running on CellaVision® DM1200 as a
reference. The positive, negative, and overall agreements (95% confidence interval within brackets)
for the individual morphologies were calculated according to CLSI document H20-A2 Reference
Leukocyte (WBC) Differential Count (Proportional) and Evaluation of Instrumental Methods, Approved
Standard-Second Edition. The results are presented in the table below.

Overall Positive Negative Number of

Cell class
Agreement Agreement Agreement samples

Segmented 94.8% (92.7% - 92.5% (87.0% - 95.6% (93.3% - 598

neutrophils 96.3%) 95.7%) 97.1%)

Band neutrophils | 99.3% (97.8% - - 99.8% (98.6% - 402
99.7%) 100.0%)

Lymphocytes 93.8% (91.6% - 87.0% (81.1% - 96.5% (94.3% - 598
95.5%) 91.2%) 97.9%)

Monocytes 92.0% (89.5% - 80.9% (73.5% - 95.2% (92.9% - 598
93.9%) 86.6%) 96.8%)

Eosinophils 97.3% (95.7% - 91.3% (79.7% - 97.8% (96.2% - 598
98.3%) 96.6%) 98.8%)

Basophils 96.0% (94.1% - 67.4% (53.4% - 98.5% (97.2% - 598
97.3%) 78.8%) 99.3%)

Accuracy results for WBC differential count

Comparison studies were conducted at 3 sites. The results from the CellaVision® DC-1 were
compared with the CellaVision Peripheral Blood Application running on CellaVision® DM1200 as a
reference. 200-cell differential counts were performed by qualified blood examiners. The study was
performed according to CLSI document H20-A2Reference Leukocyte (WBC) Differential Count
(Proportional) and Evaluation of Instrumental Methods, Approved Standard-Second Edition. The results
are presented in the table below.

Cell class Slope Intercept (%) R2 Number of samples
Segmented neutrophils 0.999 0.0012% 0.98 598
Band neutrophils 0.7047 0.0011% 0.6831 402
Lymphocytes 0.991 0.0001% 0.98 598
Monocytes 0.9874 0.0014% 0.94 598
Eosinophils 1.0079 0.0011% 0.96 598
Basophils 0.9431 0.003% 0.928 598

Repeatability for WBC differential count

Repeatability studies were run at 3 sites based on the CLSI document EP05-A3 Evaluation of
Quantitative Measurement Procedures; Approved Guideline-Third Edition. From each sample, 2 slides
were prepared (slide A and B). The slides were then run 2 times a day (both A and B at each run) for
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20 days. The results are presented in the table below for a representative low and a high
concentration sample respectively.

Cell class Concentration Mean Concentration (%) | SD (%) @ CV (%)
Segmented neutrophils | Low 17.25% 0.33% 1.93%
High 90.07% 1.78% 1.97%
Band neutrophils Low 0.08% 0.26% 314.2%
High 13.32% 1.65% 12.41%
Lymphocytes Low 3.10% 0.87% 28.1%
High 50.93% 2.53% 4.96%
Monocytes Low 0.92% 0.57% 61.96%
High 27.86% 1.41% 5.08%
Eosinophils Low 0.06% 0.17% 298.14%
High 4.24% 1.06% 25.04%
Basophils Low 0.01% 0.06% 894.43%
High 10.6% 1.81% 17.03%

Reproducibility for WBC differential count

The reproducibility study was run based on the CLSI document EP05-A3 Evaluation of Quantitative
Measurement Procedures; Approved Guideline-Third Edition. From each sample, 5 slides were prepared.
The slides were then run at 3 sites for 5 days at each site. The results are presented in the table
below for a representative low and a high concentration sample respectively.

Cell class Concentration Mean Concentration (%) @ SD (%) CV (%)
Segmented neutrophils | Low 26.33% 1.52% 5.79%
High 82.92% 3.40% 4.10%
Band neutrophils Low 0.09% 0.24% 271.15%
High 1.96% 1.55% 79.02%
Lymphocytes Low 10.75% 2.89% 26.90%
High 44.53% 15.51% 34.84%
Monocytes Low 1.41% 1.16% 82.50%
High 24.35% 4.62% 18.98%
Eosinophils Low 0.01% 0.06% 866.03%
High 11.55% 1.86% 16.14%
Basophils Low 0.01% 0.08% 627.5%
High 0.83% 0.51% 61.40%
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RBC comparison study

Comparison studies were run at 3 sites. The results from the CellaVision® DC-1 were compared with
the CellaVision Peripheral Blood Application running on CellaVision® DM1200 as a reference. The
positive, negative, and overall agreements (95% confidence interval within brackets) for the groups
color, size, and shape were calculated according to CLSI document EP12-A2 User Protocol for
Evaluation of Qualitative Test Performance; Approved Guideline - Second Edition. The results are
presented in the table below.

Comparison

Color

Size

Shape

Overall
Agreement

79.9% (76.4% -
82.9%)

88.2% (85.3% -
90.6%)

85.2% (82.0% -
87.8%)

Positive
Agreement

87.8% (82.3% -
91.8%)

89.8% (86.3% -
92.2%)

87.3% (82.3% -
91.0%)

Negative
Agreement

76.3% (71.9% -
80.2%)

84.8% (79.0% -
89.2%)

83.8% (79.6% -
87.3%)

Repeatability of RBC morphological characteristics

Number of
samples

586

585

586

Repeatability studies were run at 3 sites based on the CLSI document EP05-A3 Evaluation of
Quantitative Measurement Procedures; Approved Guideline-Third Edition. From each sample, 2 slides
were prepared (slide A and B). The slides were then run 2 times a day (both A and B at each run) for
20 days. The grading agreement for each sample was then calculated by determining the relation
between the occurrence of true grade for each morphological characteristic and the total number of
runs. The achieved agreement for each morphological characteristic is presented in the table below.

Morphology

Polychromatic cells

Hypochromatic cells

Anisocytosis (CV)

Microcytes
Macrocytes

Poikilocytosis

Agreement

62.5% - 100%
50.0% - 100%
60.0% - 100%
85.0% - 100%
56.25% - 100%

96.25% - 100%

Reproducibility of RBC morphological characteristics

The reproducibility study was run on 4 samples based on the CLSI document EP05-A3 Evaluation of
Quantitative Measurement Procedures; Approved Guideline-Third Edition. From each sample, 5 slides
were prepared. The slides were then run at 3 sites for 5 days at each site. The grading agreement for
each sample was then calculated by determining the relation between the occurrence of true grade
for each morphological characteristic and the total number of runs. The achieved agreement for
each morphological characteristic is presented in the table below.
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Morphology Agreement
Polychromatic cells 36% - 100%
Hypochromatic cells 63% - 100%
Anisocytosis (CV) 51% - 100%
Microcytes 96% - 100%
Macrocytes 51% - 100%
Poikilocytosis 65% - 80%

PLT comparison study

Comparison studies were run at 3 sites. The results from the CellaVision® DC-1 were compared with
the CellaVision Peripheral Blood Application running on CellaVision® DM1200 as a reference. The
agreement between the two methods was evaluated by summarizing the results in the table below.

DM1200 (number of samples)

DC-1 (number of S Total
samples) Significantly Decreased | Normal  Increased
decreased
Significantly decreased | 140 16 0 0 156
Decreased 6 135 13 0 154
Normal 0 10 173 10 193
Increased 0 0 17 78 95
Total 146 161 203 88 598

The achieved Cohen's Kappa coefficient was 0.89.
Repeatability of PLT analysis

Repeatability studies were run at 3 sites based on the CLSI document EP05-A3 Evaluation of
Quantitative Measurement Procedures; Approved Guideline-Third Edition. From each sample, 2 slides
were prepared (slide A and B). The slides were then run 2 times a day (both A and B at each run) for
20 days. The agreement for each PLT level was then calculated as a relation between the number of
runs reporting the sample PLT level and the total number of runs. . The achieved agreement for the
different PLT levels are presented in the table below.

PLT Level Agreement (%)
Significantly decreased 100%
Decreased 100%
Normal 100%
Increased 100%
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Reproducibility of PLT analysis

The reproducibility study was run on 4 samples based on the CLSI document Evaluation of
Quantitative Measurement Procedures; Approved Guideline-Third Edition. From each sample, 5 slides
were prepared. The slides were then run at 3 sites for 5 days at each site. The agreement for each
PLT level was then calculated as a relation between the number of runs reporting the sample PLT
level and the total number of runs. The achieved agreement for the different PLT levels are
presented in the table below.

PLT Level Agreement (%)
Significantly decreased 100%
Decreased 100%
Normal 97.3%
Increased 98.6%

7.2.2 Performance specification for scan

Throughput data and disk space requirements for the scanned slides

Scan area size Resolution Processing time Disk space (MB)
5x5mm Low 10 min. 30

5x5mm Medium 10 min. 125

5x5mm High 15 min. 500

10x 10 mm Low 35 min. 125

10x10 mm Medium 35 min. 500

10x10 mm High 60 min. 2000

The given values are only approximates. Processing time and required disk space vary depending on
sample.

7.3 Accessories

7.3.1 Slides

You can use slides with ground edges and clipped, round, or right angle corners with the analyzer.
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Specification Description

Standard ISO 8037/1-1986

Material Glass

Length 75.0 to 76.0 mm

Width 25.0to0 26.0 mm

Thickness 0.9to1.2mm

Corners Clipped, round, or right angle.

Edges Ground edges.

Labeling We recommend that you label the slide with a barcode as specified in 7.3.2

Barcodes below.

7.3.2 Barcodes

This section applies only if you use the optional barcode reader.

You must label all slides with an order ID. If you use the optional barcode reader, you can label your
slides with a barcode containing the order ID. The barcode mustn't contain any other order data.

[ i

2343545

The order ID can be up to 24 characters (ASCII) long, including spaces. It can't begin with:
» PB

* BFS

* ERR

* QC (reserved for cell location test slides)

e Aspace

You can print the barcode on a label or directly onto the slide. The print must be in high contrast to
the background, and it must be resistant to immersion oil.

If you print the barcode directly onto a slide, it must be printed on a white, smooth, frosted area of
the slide.
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Leave at least 1 mm between the edge of the slide and the actual label. Otherwise, there is a risk that
the slide is not properly fixed during slide processing.

If, for some reason, you can't print barcodes containing the order ID, you can use pre-printed
barcode labels with the prefix “ER". You can enter an order ID manually for all slides that begin with
letters “ER". You can order the pre-printed labels from your local vendor.

0 Important!
Avoid getting immersion oil on the barcode as it may prevent the analyzer from reading
the barcode correctly.

Supported linear barcodes

The analyzer supports these standards for linear barcodes:
« Code 39

» Code 128

» Codabar/NW-7

e Interleave 2 of 5

Supported 2D barcodes
The analyzer supports these standards for 2D barcodes:

+ Data Matrix

OQR

Barcode resolution

Barcode standard Cell size, mil
QR 13

Data Matrix 9

Code 39 7

Code 128 7
Codabar/NW-7 7

Interleave 2 of 5 7

CellaVision AB has verified these barcode resolutions.

Quiet zone

You must leave a blank region, free from all markings, around the barcode. This region is called the
“quiet zone". The following table specifies the minimum size of the quiet zone.
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Barcode standard Minimum quiet zone, all sides

Data Matrix 1 light module

QR 4 light modules

Other According to barcode standard specification.

4 N

2343545

Examples of barcodes where the quiet zone is marked in orange for illustrative purposes.

7.3.3 Immersion oil

Warning!
Avoid getting immersion oil on your skin. Wear protective gloves before you handle the oil,

slides, or other parts that can come into contact with the oil. Immersion oil can cause skin
sensitization. If you get oil on your skin, clean it off with soap and water.

c Caution!
To help prevent slide processing faults and damage to the analyzer, use only the
CellaVision® immersion oil.

Firefighting procedure

Specification Description

Flash point > 149°C (> 300°F)

Upper explosive limit Not applicable

Lower explosive limit Not applicable

Fire fighting media Carbon dioxide, foam and dry chemical

Unusual fire and explosion hazards Containers should be kept cool in the event of fire
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8 BUTTONS, ICONS, AND INDICATORS

This section describes the buttons, icons and indicators you can see in the CellaVision DM Software
in the System Control View. To view the tooltip for a button, point to it with your mouse.

The buttons, icons and indicators for other views in the CellaVision DM Software are described in the
CellaVision Review Software Instructions for Use.

8.1 System Control View

System Control ViewE is the view on the analyzer where you process slides.

System control buttons
¥ Stop slide processing.
> Start or resume slide processing.

W Clear log.

Analyzer status

Analyzer status is shown as text on the toolbar.
e Idle

e Analyzing

e Stopped

e Paused

e Error

Analyzer indicators
ﬂ Hood is open.
E Input hatch is open.

ﬂ Input hatch and hood are open.

8.2 Slide status

Slide status is shown in the System Control View.
> Processing. Slide is being processed.

~/ Finished. Slide was processed without warnings or errors.
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£:% Warning. A problem occurred. Images and preliminary results were saved to the database and
you may still be able to perform review and verification.

W Stopped: User stopped slide processing and no results exist.

“ Error. All ordered analyses failed and no results exist.

8.3 PPA status

PPA status is shown on the status bar in the System Control View.

EVaIid PPA card. Balance remaining on the card is shown next to the icon.

No connected PPA card.

8.4 Status light

Status light on the analyzer provides you with information on its current state.

©

\ 4

0.

Status light Description
Steady yellow Analyzer is starting up.
Analyzer is processing a slide.

Flashing green | Analyzer has finished the startup procedure.

Analyzer has completed slide processing. You can now remove the slide.

Steady green Analyzer is idle and ready to use.
Flashing red Mechanical error.
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REVISION HISTORY

Revision 2021-10-31

Section

1.2.2 Symbols on
page 10

Revision 2021-09-13

Change

Symbol for date of manufacture added. References to specific directives

removed for symbols manufacturer and CE-marks.

Section

1.2.3 General safety on
page 12

1.4 Applications on
page 16

1.4 Applications on
page 16

2.2.3 Staining on
page 26

7.1.4 Electrical

specification on
page 98

7.2.1 Performance
specification for
CellaVision Peripheral
Blood Application on
page 99

Revision history above

Change

Information added that users must report any serious incidents that
occur in relation to the analyzer.

Information added on whether the applications are qualitative, semi-
gquantitative, or quantitative.

Information added about the mathematical methods used when
calculating the results.

Staining recipes removed.

Power supply specification removed.

Performance data updated in accordance with document variant PM-
10895-03, submitted to FDA in October 2020.

Appendix with revision history added.
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GLOSSARY

A

analysis

The overall process of using the system,
including loading slides, processing slides,
verification, signing, and reporting results.

anisocytosis

Variation in size among RBCs.

C

characterization

To determine the morphology characteristics
of an RBC sample. The result of the
characterization is reported as grades.

confirm cell counter results

To confirm the cell counter results for WBC,
RBC, or PLT instead of doing a full manual
analysis. When the user chooses to confirm cell
counter results, only a confirmation flag for
that result is sent to the LIS.

D

duplicate slide differential

Two different persons sign one slide each in
the order. The average result is presented.

G

grade

A number representing the relative amount of
cells of a certain type in an RBC sample.

grid square

A section of the PLT or RBC overview image.

H

HPF

Microscopic high-power field

in-vitro

Outside the living body; in an artificial
environment.

L

LIS

Laboratory Information System.

M

MGG

May Grunwald Giemsa, a Romanowsky stain
for blood smears.

mini map
An overview image of the analysis area.

multi-slide order

An order including more than one slide from
one sample.

N

non-WBC
Cells and objects identified as not being WBCs.

not classed

Cells and objects that the user cannot identify
and wants to exclude from the differential
count.

(o)

operator

The person who works with the system. Also
referred to as user.
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order

An order contains patient data and the
information about what type of analyses that
are to be performed (for example WBC, RBC)
on the slides belonging to that order. Each
order is identified by its order ID and the
concept of the order and the order ID is used
throughout the entire analysis to keep track of
patient data, images, results, and so on. An
order is generally received from the LIS or
created in CellaVision DM Software.

order ID

Unique order identifier. There can be several
slides with the same Order ID but with
different slide numbers.

other

Cells that the user identifies as WBCs, but of a
type other than those listed. Will be included in
the differential count.

P

pathology review

A function that allows you to mark any slide so
that a pathologist can find and review it.

patient ID

A unique identifier for the patient.

pending order

An order manually added to the database,
waiting to be processed.

PID

Positive Identifier. Generally refers to the
barcode on the slide.

PLT
Platelet, thrombocyte.

PLT estimate

Estimation of the PLT concentration.

PLT estimate factor

A pre-determined factor to calculate the PLT
estimate.

poikilocytosis

Presence of abnormally shaped red blood cells.

pre-characterization

The characterization that the system suggests
for the RBC morphology of a sample.

pre-classification

The classification that the system suggests for
each WBC.

processing slides

The sequence of events from when the system
starts working with a slide until it is finished.

R

RBC
Red blood cell, erythrocyte.

re-classification

The user changes the pre-classification.

reference cells

A collection of WBCs with typical
characteristics, available in the Peripheral
Blood Application.

Romanowsky stain

An eosin-methylenblue solution for staining of
blood smears. Wright and MGG are examples
of different Romanowsky stains.

S

sign

The final confirmation of the analysis results
before locking and reporting them.

slide ID

The barcode number on the slide (PID). Same
as Order ID.

114

PM-10895-01
Revised: 2021-10-31



e Gossany ||

slide number

A sequential number to identify each slide in a
multi-slide order.

U

unidentified

Cells and objects which the system cannot pre-
classify.

Vv

verification

The user's review of WBC, RBC, and PLT. For
example re-classification and confirmation of
WBCs.

w

WBC
White blood cell, leukocyte.

Wright

A Romanowsky stain for blood smears.

Wright-Giemsa

A Romanowsky stain for blood smears.
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